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Using the Plant Applications Client 

The Plant Applications Client provides a customizable environment for using Plant Applications views 

and displays to access your plant data. Access to views and displays is determined by your user 

name and password. A merged, Manufacturing Database (MDB) is available with Plant Applications, 

version 6.0. If Plant Applications has been merged with S95 in Proficy SOA, the Plant Applications 

Client displays will reflect the merged data. 

TIP:  If you are using Windows Authentication and logging into a domain other than the default 

domain, you will need to include the fully qualified domain name (FQDN). Contact your site 

administrator if you need assistance. 

The Plant Applications Client has these functions: 

 Contains all Plant Applications controls and displays 

 Allows for user customizable environment 

 Contains built-in cross-application automation 

 Allows for direct access to content on Plant Applications Web Server 

NOTE:  If you do not have access to a particular display, which is part of a view, you will 

still be able to open the view, but you will see a message informing you that you do not 

have permission to open the particular display. 

Different Plant Applications modules enable different types of displays in the Plant Applications Client. 

Each display is also exposed as an ActiveX control, and may be used outside of the Plant 

Applications Client in any ActiveX container, such as Intellution’s iFIX Workspace. 

Plant Applications Client sessions can be configured by an administrator to automatically time out and 

enter a protected state. When you log back in, displays to which you have access are reopened. Also 

refer to Manually Timing Out from a Client Session. 

A number of Plant Applications displays are available for viewing through the Proficy Client, which is 

installed as part of Proficy Workflow. Thus, Proficy Client users have available a way to consolidate 

displays into a single client for viewing. Plant Applications licensing is required to view Plant 

Applications displays in the Proficy Client. Refer to Using Plant Applications Displays in the Proficy 

Client to set up the Proficy Client to view Plant Applications displays.   

Logging In and Switching Users 

This information applies to the Plant Applications Client program. 

You may be required to provide credentials to log into the Client. While working in the Plant 

Applications Client, another user can log in without having to close and then re-open the Plant 

Applications Client. 

To log in: 

When you start the Plant Applications Client, you are challenged for authentication if your current 

credentials (user name and password) do not match requirements. For example, if Windows 

authentication is not enabled, you must use Plant Applications (Proficy) credentials. When challenged 

for credentials by the Plant Applications Server Login dialog, follow these steps: 

1. Select Proficy Authentication to submit a user name and password defined in Plant 

Applications. Optionally, select Windows Authentication to submit credentials that are your 

Windows authentication credentials.   
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2. If choosing Windows Authentication, choose the domain name from the drop-down 

selection. If your domain is not listed, enter the fully qualified domain name (FQDN). 

To switch users: 

1. From the File menu, select Switch User. The Plant Applications Server Login dialog box 

appears. 

2. The new user should do the following: 

a. In the UserName box, type your Plant Applications user name. 

b. In the Password box, type your Plant Applications password. 

c. Click OK. 
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Manually Timing Out from a Client Session 

An option is available in the Plant Applications Client to manually initiate a session timeout, thus 

requiring a user to log back in.  To initiate a manual session timeout, do one of following: 

 Select Session Timeout from the File menu. 

 Mouse-over and click the Session Timeout button  from the Client toolbar. 
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Common Tasks 
Protect Data 

This information applies to the Plant Applications Client program. 

The Unauthenticate feature is a security feature that helps ensure the integrity of your data. If you 

activate this feature, verification will be required for any changes made. 

To help prevent unauthorized changes, you can activate the Unauthenticate feature to ensure that 

any changes will require user verification. This helps prevent unauthorized changes, in the event you 

leave your workstation unattended. 

After a change has been approved, the Unauthenticate feature becomes available. After you activate 

the feature, it is not available unless a change has been made. 

If Data Security User sign-off or Data Security Approver sign-off has been given, any changes will 

reset the sign-off status to <Unapproved>. 

The Unauthenticate feature will be available only if electronic signature authorization is 

required for some element of the display, such as variables or products. 

To activate the Unauthenticate feature: 

 Do one of the following: 

o From the File menu, select Unauthenticate. 

o On the toolbar, click the Unauthenticate button . 

Accessing Web Reports 

This information applies to the Plant Applications Client program. 

You can gain access to reports that have been published to the Plant Applications Web Report 

server, without having to log out of the Plant Applications Client. Keep in mind that the Web content 

that is available to you is determined by your Plant Applications user name and password. 

To gain access to Plant Applications web reports: 

1. From the File menu, click Open Report Menu. 

2. Type your Plant Applications user name and password and click Logon. 

Viewing Hyperlinks 

If enabled, the HyperLinks Menu is displayed in the default location with the default size, or if the 

Hyperlinks Menu was previously resized or repositioned during the current Schedule View session, it 

is displayed according to these settings. 

To display the HyperLinks menu: 

 Select Display HyperLinks from the View Menu, or click the Display HyperLinks tool icon. 

Using the Shortcut Bar 
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The Shortcut Bar is an additional menu bar within the Plant Applications Client. There are basically 

two types of shortcuts you can add to the Shortcut Bar: shortcuts to Displays and shortcuts to external 

applications. You can create shortcuts to Displays on different servers and shortcuts to external 

applications, such as Excel. 

To help you organize your shortcuts, you can create Groups on the Shortcut Bar. You can either 

create your Groups first and then add the shortcuts to a Group, or you can add your shortcuts, create 

your Groups and then add the shortcuts to the Groups. 

To open the Shortcut Bar do one of the following: 

 From the Window menu, select Shortcut Bar. 

 Press Ctrl + B. 

Creating Shortcuts 

This information applies to the Plant Applications Client program. 

Adding shortcuts to your Shortcut Bar allows you quick access to a displays and external applications 

or documents by clicking the shortcut. 

You can create shortcuts to displays on the current server or even on other servers. You can also 

create a shortcut to an external application, such as Excel. 

To create a shortcut to a display: 

1. Open the Shortcut Bar. 

2. If your Shortcut Bar is organized by Groups, select the desired group. 

3. Open a display. 

4. Right-click on the Shortcut Bar and click Add Shortcut to Current Display. 

If you have more than one display open, the active display will be added to the 

Shortcut Bar. 

Create a Shortcut to an External Application 

1. Open the Shortcut Bar. 

2. If your Shortcut Bar is organized by Groups, select the desired group. 

3. Right-click on the Shortcut Bar and click Add Link to External Application. The Select 

Executable to Link dialog box appears. 

4. Navigate to the application (*.EXE) you want to link to and click Open. 

The new link is added as New ListItem. 

5. To rename the short cut, right-click on the shortcut and click Rename Item. The name field 

becomes editable. Type the new name and press ENTER. 

Editing Shortcuts 

This information applies to the Plant Applications Client program. 

You can change the name of a shortcut, if the shortcut is to a Display. If the shortcut is to an external 

application (a link), such as Excel, you can rename it, determine whether to allow opening more than 

one session of the application, and have it open a specific file or web page. 

Rename Items on the Shortcut Bar 

1. Right-click on the shortcut and click Rename Item. 
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2. Type the new name of the shortcut and press ENTER. 

Edit a Link on the Shortcut Bar 

1. Right-click on the link on the Shortcut Bar and click Edit Link. The Edit Shortcut Details 

dialog box appears. 

2. Do one or more of the following: 

a. To change the name of the shortcut, type the new name in the Shortcut Name box. 

b. In the Parameters box, you can type the path to a specific file to be opened by the 

linked-to application. For example, if you created a link to Microsoft Word, you can 

type the path to a specific .DOC file and that file will open when you click the link. 

Additionally, if you created a link to Internet Explorer, you can type the URL of the 

page you want to open when you click the link. 

If the path has spaces in it, you must enclose the complete path in double 

quotation marks (" "). 

If your path is a URL, you do not have to include the "http:\\". 

c. In the Allow Multiple Links box, do one of the following: 

o Select True if you want to allow opening multiple sessions of the 

application. 

To open multiple sessions, right-click on the link and select Open 

in New Window from the pop-up menu. 

o Select False if you want to allow opening only one session of the 

program. 

Organizing Your Shortcuts 

This information applies to the Plant Applications Client program. 

By default, the Shortcut Bar has a Main Group. To help you organize your shortcuts, you can create 

additional groups on the Shortcut Bar. You can either create your groups first and then add the 

shortcuts to a group, or you can add your shortcuts, create your groups and then add the shortcuts to 

the groups. 

Create a Shortcut Group 

1. Open the Shortcut Bar. How? 

2. Right-click on the Shortcut Bar and click Add New Group. 

The group is added as New Group. 

Rename a Shortcut Group 

1. Select the group you want to rename. 

2. Right-click on the group and click Rename Group. The group name becomes editable. 

3. Type the new group name and press ENTER. 

Add a Shortcut to a Group 

Do one of the following: 

 To add an existing shortcut to a group, click and drag the shortcut to the desired group. 

 To add a new shortcut to a group, see Creating Shortcuts. 
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Delete a Group from the Shortcut Bar 

1. Select the group you want to delete. 

2. Right-click on the group and click Delete Group. 

Delete Items from the Shortcut Bar 

Right-click on the shortcut and click Delete Item.  

Creating a Shortcut to a Report 

This information applies to the Plant Applications Client program. 

To create a shortcut to a Plant Applications report: 

1. Open the Shortcut Bar. How? 

2. Open the desired report. 

3. If your Shortcut Bar is organized into groups, select the desired Shortcut group. See 

Organizing Your Shortcuts for more information about Shortcut groups. 

4. Right-click on the Shortcut Bar and click Add Shortcut to Current Display. 

Displays 

This information applies to the Plant Applications Client program. 

After logging in to the Plant Applications Client, you will need to open either a View or Display. Keep 

in mind that the user name and password you used to log in to the Plant Applications Client will 

determine the Views and Displays you have access to. 

If you are running a Manufacturing Database (MDB), entities are aspected from Proficy SOA 

to Plant Applications and vice versa to form a merged database. Data in displays will reflect 

the combined data. Refer to the Proficy Client Help for a description of the MDB created 

through the MESCore Service Provider. 

Opening a Display 

1. From the File menu, select Open Display. The Open Display dialog box appears. 

2. Do the following: 

a. optional: Under Server, select a different server from the drop-down list, or click 

Browse  to select a new server. 

b. Under Available Displays locate the desired Display. 

Each display type is identified by an icon. Click here for more information. 

c. Click OK. 

3. If you are prompted to load a new toolbar, click Yes. 

 Identifying the Display Type 

This information applies to the Plant Applications Client program. 

Each display has an icon associated with it to help you quickly and easily identify it. 

Icon Display Type 
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Alarm View 

 

AutoLog 

 

Down Time 

 

Genealogy View 

 

Non-Productive Time View 

 

Production Overview 

 

Production Run Analyst 

 

Relative View 

 

Schedule View 

 

Sequence of Events View 

 

Trend View (Normal) 

 

Trend View (SPC) 

 

Waste View 

Entering Locations and Reasons in a Display 

This information applies to the Plant Applications Client program. 

If you have configured your reason trees, you can associate locations and reasons to specific events 

within a display. 

1. In the display, scroll to the Location column. 

2. Select a location from the drop-down list. Locations must be selected before reasons. To 

delete a reason, click Delete. 

 
3. The first reason level must be selected first, the second reason level second, and so on, up to 

the fourth reason level. 

  

Arranging Displays 

This information applies to the Plant Applications Client program. 

Displays can be either docked or tabbed. 

To change the layout of displays: 

1. From the Window menu, select Dock Current Display. 

By default, the current display will be docked at the bottom of the screen. 

2. To move a docked window, place the mouse pointer over the display's frame and click and 

drag the display to the desired position. 
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Closing a Display 

This information applies to the Plant Applications Client program. 

To close a display, do one of the following: 

 From the File menu, select Close Display. 

If you have a View open, selecting Close Display will close the topmost display in the 

view. In other words, the active display will be the one that is closed. 

 Click the Close  button on the Display. 

Views 

This information applies to the Plant Applications Client program. 

Views are a collection of displays and shortcuts. The only way to create a view is within the Plant 

Applications Client. You cannot use the Plant Applications Administrator to create a view. 

Creating a View 

1. Open and position displays as desired. 

2. Add any desired shortcuts to the Shortcut Bar, and add any reports to the Report Menu. 

3. Format open displays as desired, such as Time Formatting, Column Visibility, Column Widths, 

and Comment Visibility. 

4. From the File menu, click Save View As. The Save View As dialog box dialog box appears. 

5. Do the following: 

a. optional: Select a different server from the Server drop-down list, or click Browse 

 to select a different server. 

b. In the View Name box, type the name of your View. 

c. Click OK. 

Opening a View 

This information applies to the Plant Applications Client program. 

After logging in to the Plant Applications Client, you will need to open either a view or display. Keep in 

mind that the user name and password you used to log into the Plant Applications Client will 

determine the views and displays you have access to. 

To open a view: 

1. From the File menu, select Open View. The Open View dialog box appears. 

2. Do the following: 

a. optional: Under Server, select a different server from the drop-down list, or click 

Browse to select a new server. 

b. Under Available Views, locate the desired view. 

c. Click OK. 

3. If you are prompted to load a new toolbar, click Yes. 
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Saving Views 

This information applies to the Plant Applications Client program. 

Views are a collection of Displays and Shortcuts. Within the Plant Applications Client, you can open 

the Displays, arrange them in the order you want to view them on your screen, and then save them as 

a View. The positions of the Displays within the View are permanently saved, so that the data 

displayed and the look and feel remains consistent regardless of who opens the View. 

To save changes to a view: 

1. Open the View and make the desired changes. 

Before you can save any changes, you will need to click on every display in the view. 

2. From the File menu, click Save View. 

Closing a View 

This information applies to the Plant Applications Client program. 

To close a View: 

From the File menu, click Close View. 

Server Tasks 

Regardless of the Display or View you have open, you can perform several server-related tasks. 

Add a new server 

Delete a server 

Edit the current server 

Connect to a different server 

Disconnect from the current server 

Change your password 

Adding a New Server 

This information applies to the Plant Applications Client program. 

1. From the File menu, click Server. The Connect Server dialog box appears. 

2. Right-click inside the dialog box and click New. The Server dialog box appears. 

3. Do the following: 

a. In the Server Name box, type the name of the server you want to add. 

b. In the User box, type your Plant Applications user name. 

c. In the Password box, type your Plant Applications password. 

d. Click Advanced to set this server as the default server or to automatically connect to 

this server when you log on to the Plant Applications Client. 

If you select the Default Server option, the Connect at Startup option is 

automatically selected. 

e. Click OK. 
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4. Click Close. 

Deleting a Server 

This information applies to the Plant Applications Client program. 

1. From the File menu, select Server. The Connect Server dialog box appears 

2. Right-click on the server you want to delete and click Delete. 

3. Click Yes to confirm the deletion. 

Editing the Current Server Information 

This information applies to the Plant Applications Client program. 

1. From the File menu, select Server. The Connect Server dialog box appears 

2. Right-click on the server you want to edit and click Edit. The Server dialog box appears. 

3. Make any necessary changes and click OK. 

4. Click Close to close the Connect Server dialog box. 

Connecting to a Different Server 

This information applies to the Plant Applications Client program. 

You must have a site user name and password on the server you want to connect to. 

Before you can connect to a different server, you'll need to first add it. Click here for information on 

adding a server. 

1. From the File menu, select Server. The Connect Server dialog box appears. 

2. Right-click on the server you want to connect to and click Connect. 

3. When prompted, enter your user name and password and click OK. 

Disconnecting from the Current Server 

This information applies to the Plant Applications Client program. 

1. From the File menu, select Server. The Connect Server dialog box appears. 

2. Right-click on the server you want to disconnect from and click Disconnect. 

3. Click Close. 

Changing your Plant Applications Password 

This information applies to the Plant Applications Client program. 

When you change your password, you are changing it only for the selected server. You must use the 

new password for everything you have access to on the selected server. 

1. From the File menu, select Server. The Connect Server dialog box appears. 

2. Right-click on the desired server and click Change Password. The Plant Applications 

Server Change Password dialog box appears. 

3. Do the following: 

a. In the Old Password box, type your current password. 
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b. In the New Password box, type your new password. 

c. In the Retype Password box, retype your new password. 

d. Click OK. 

4. Click Close. 

Viewing Reports 

This information applies to the Plant Applications Client program. 

The Report menu is a way to quickly access often-used reports. 

Adding a Report to the Report Menu 

1. Open the Shortcut Bar. How? 

2. While viewing the report you want to add, right-click on the Shortcut Bar and click Add 

Current Report to Reports Menu. 

3. From the Tools menu, click Reports. The list of reports currently attached to the Report 

menu will be displayed. 

4. Selecting the report in the Report menu will browse to the report directly without the Web 

Client menu. 

Creating a Shortcut to a Report 

This information applies to the Plant Applications Client program. 

To create a shortcut to a Plant Applications report: 

1. Open the Shortcut Bar. How? 

2. Open the desired report. 

3. If your Shortcut Bar is organized into groups, select the desired Shortcut group. See 

Organizing Your Shortcuts for more information about Shortcut groups. 

4. Right-click on the Shortcut Bar and click Add Shortcut to Current Display. 

Opening the Report Menu 

This information applies to the Plant Applications Client program. 

Opening the Report menu provides you access to all the Web reports that have been created and are 

available to you based on your user name and password. 

To open the Report menu: 

1. From the File menu, select Open Report Menu. 

2. The report window will open your default Plant Applications Web Server. You may be required 

to type your Plant Applications user name and password if the system cannot automatically 

authenticate you. 

After using the Web Server, click the Logout button  to prevent unauthorized 

access to your Web reports. 
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Alarm View Display 
Anatomy of an Alarm View Display 

This information applies to the Plant Applications Client program. 

The Alarm View Display is a real-time application designed to show active and historical alarms on 

key variables. Alarms conditions are based on alarm rules that compare data to product-based 

specification limits in real time. In order to use the Alarm View Display, you must first configure 

alarms. Refer to How to Configure Alarms. Key elements of the display include the following: 

 Acknowledgement column showing Yes or No 

 Comments shown below each Alarm 

 Time Range of Alarm shown 

 Cause Reasons shown 

 Actions taken shown 

Key Uses 

 Alarm critical variables and require acknowledgement 

 Expose operating procedures on alarm conditions 

 Enter Reasons and Comments for alarm conditions 

Key Data 

 Alarm start times and end times 

 Alarm condition 

 Alarm Cause Reasons and corrective actions 

 Alarm comments 

Editing Alarm Details 

To edit alarm details: 

This information applies to the Plant Applications Client program. 

1. In the Alarm View display, double-click an alarm or right-click an alarm and select Edit Alarm. 

The Edit Alarm dialog box appears. 

2. On the General tab, select or clear Ack Status. Selecting Ack Status will acknowledge the 

alarm. Clearing Ack Status will set the alarm status to Not Acknowledged. 

3. On the Cause tab, select a cause for the user-defined event. 

4. On the Actions tab, select an action for the user-defined event. 

5. On the Research tab, do the following: 

a. From the User list, select a user who is responsible for researching the user-defined 

event. 

b. From the Research Status list, choose either Open or Closed. 

c. Click Open Date to identify the date the case was opened. 
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d. Click Close Date to identify the date the case was closed. 

6. Click the History tab to view a history of the event. 

7. Click OK when finished. 

 Filter and Sort Alarms 

This information applies to the Plant Applications Client program. 

1. Right-click within the Alarm window. 

2. Select Filter Options. 

3. Select Alarm Priorities and Acknowledgement. 

4. Select OK when finished. 

Search For Historical Alarms 

This information applies to the Plant Applications Client program. 

1. Select an Alarm to research history for. 

2. Right-click within the Alarm window. 

3. Select Quick Search. 

4. Quick Search will find recent Alarms for the selected Variable. 

5. For A Complex Query, right-click and select Query Wizard. 

6. Identify Alarm Variables to search. 

7. Identify Alarm Variables to search for. 

8. Select other Search Criteria such as Priority and Reasons. 

9. Select Search to return results to the Alarm Window. 
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Autolog Display 
Anatomy of an Autolog Display 

Autolog displays are identified by the Autolog icon . The information in this topic applies to the 

Plant Applications Client program. 

Production Event and User-Defined Event (UDE) data may be locked based on the event status to 

prevent changes. Only transitions to other locked statuses are allowed for statuses that have been 

locked. In Autolog displays, related data-entry fields are locked.   

Data can be entered, filtered, and summarized by time or event. Comments, product specifications, 

and operating procedures can be applied and reviewed. 

Based upon the quality of the data, disposition decisions can be made. 

You can view more information about a cell, including its status, by right-clicking on the cell and 

selecting Cell Information. 

Event-based Autolog Displays 

 Variables on the left side of Display 

 Values are color coded by alarm limit 

 Comments are indicated with an underline 

 Event information at the top of each column 

 Test scheduling indicated by cell background color 

 Product specification for each cell shown along the bottom 

Time-based Autolog Displays 

 Time interval at the top of each column 

 Manually entered values in cells 

 Automatic process data from historian shown in cells 

 Comment window at the bottom 

Entering Data in an Autolog Display 

This information applies to the Plant Applications Client program. 

NOTE:  The “unavailable” status of an Autolog cell means there is no data available to 

populate the cell. For example, test data is collected less frequently than the Autolog display 

is updated. Unavailable cells may be locked so that only an administrator can enter a value. 

To enter data: 

1. Select the cell where you want to enter the data. 

2. Press the spacebar to activate the cell. 

3. Do one of the following: 
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o If the variable is a custom data type (defines what data can be entered in the variable 

cell), select a value from the drop-down list. 

o Type the value into the cell. 

Adding Comments to an Autolog Display 

This information applies to the Plant Applications Client program. 

Adding comments is a great way to provide additional information. Comments can be either text that 

you type or you can paste a link to an external document, such as a Microsoft Word document. 

Keep in mind that if you paste a link to a document, the document cannot be moved to a different 

folder or directory; otherwise, the link will be broken and the document will not be found. 

To add comments to data in a cell: 

1. Select the cell. 

2. Right-click and choose View Comments. The Comment dialog box appears. 

3. In the Comment box, type your comments or paste a link to an external file. 

4. Click the Save Comment button . The value in the cell will be underlined. 

To add comments to column or row headings: 

1. Click the column or row heading you want to comment. The Comment dialog box appears. 

2. In the Comment box, type your comments or paste a link to an external file. 

3. Click the Save Comment button . The value in the cell will be underlined. 

Viewing Product Specifications in an Autolog Display 

This information applies to the Plant Applications Client program. 

You can view a variety of product specifications for each variable in your Autolog Display. When you 

add a specification, a column for each value is added to the Autolog Display. 

Adding too many specifications will prevent you from scrolling to the data columns. 

To view Product Specifications: 

 While viewing an Autolog Display, select the View menu and then do one or more of the 

following: 

o Click Reject Limit Columns to view the upper and lower reject limits for all variables 

o Click Target Column to view the target specification for all variables 

o Click User Limit Columns to view the upper and lower user limits for all variables 

o Click Warning Limit Columns to view the upper and lower warning limits for all 

variables 

o Click Test Frequency Column to view the test frequency for all variables 

Making Product Changes on an Autolog Display 

This information applies to the Plant Applications Client program. 

You can either add a product to change or you can update a product change. 
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To Make Product Changes: 

1. While viewing your Autolog Display, select the Actions menu, and then click Change 

Product. 

2. In the Change Product dialog box, under Product Changes On Sheet, click the production 

unit. 

3. Under Products, select the product you want to change to and then click Add. 

4. optional: Under Start Time change the date and time you want the product change to occur. 

5. Click OK. 

To Update a Product Change: 

1. While viewing your Autolog Display, select the Actions menu, and then click Change 

Product. 

2. In the Change Product dialog box, under Product Changes On Sheet, click the product 

change you want to update. 

3. Do one or more of the following: 

o To change the start time, under Start Time, change the start date and time. 

o To change the product, under Products, click a different product. 

4. Click Update. 

5. Click OK. 

Searching for Events in an Autolog Display 

This information applies to the Plant Applications Client program. 

To search for events: 

1. From the Tools menu, click Goto Event. The Search Production Event <event name> 

dialog box appears. 

2. Do one of the following: 

o To search for search for a specific event, in the <event name> Search box, type the 

event number, or any portion of the event number, and click Search. 

o To search for all events, click Search. 

3. In the list of events, select the event you want to go to and click OK. 

Search Shortcuts 

In an Autolog display, you can quickly locate and put focus on a specific cell using either your 

keyboard or a scanner. If you are using a keyboard, there is no visual indication that anything is 

happening. 

NOTE: You can enter the timestamp first and then the variable ID or enter the variable ID first 

and then the timestamp. 

To locate a variable: 

1. Type or scan the tilde character (~). 

2. Type or scan the variable ID. 
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3. Press ENTER or scan a carriage return. 

4. Type or scan the tilde character (~). 

5. Type or scan the timestamp of the variable using the format: YYMMDDHHMMSS 

6. Press ENTER or scan a carriage return. 

EXAMPLE: Using the keyboard to locate the value for a variable with the ID of 2 and with a 

timestamp of 29-Nov-06 09:30:25, you would type: 

1. ~ 

2. 2 

3. Press ENTER. 

4. ~ 

5. 061129093025 

6. Press ENTER. 

Viewing Production Event Details in an Autolog Display 

This information applies to the Plant Applications Client program. 

To view Production Event details: 

1. Open the desired Autolog Display. 

2. Scroll to the column of the Event to edit and select a cell in the Event's column. 

3. From the Action menu, click Edit <event name>. 

4. In the <event name> Information dialog box, make any necessary changes. 

5. Click OK. 

Showing Event Status in an Autolog Display 

This information applies to the Plant Applications Client program. 

If you do not see Status as a column heading in your Autolog display, you can edit the display options 

to temporarily view it. If you want to permanently add Status as a column heading, you will need to 

save the display as a view (How?). 

Production and User-Defined Event data may be locked based on the event status to prevent 

changes. Only transitions to other locked statuses are allowed for statuses that have been locked. In 

an Autolog display, related data-entry fields are locked. Refer to Locking Production Statuses. 

Adding a Status Column 

Permanently adding a Status column heading to show Production and User-Defined Event status can 

be done by changing the display option in the Administrator. Refer to Autolog Display Options 

Settings. 

To temporarily add "Status" as a column heading: 

1. Open the desired Autolog display. 

2. From the View menu, click Display Options. 



Plant Applications Client 

27 

3. In the Display Options dialog box, on the Display tab, select the Status option. 

4. Click OK. 

Changing a Production Event Status in an Autolog 

Display 

This information applies to the Plant Applications Client program. 

Depending on how the Autolog Display has been configured, there are two methods for changing the 

status of a Production Event. If the display option, UseExtendedEdit, is set to True you can use the 

first method. If the option is set to False, you will need to use the second method in order to change 

the Production Event status. 

UseExtendedEdit is a display option that can be changed only through the Plant Applications 

Administrator. 

Keep in mind that this only applies if the display is an event-based Autolog Display. 

Production Event data may be locked based on the event status to prevent changes. Only transitions 

to other locked statuses are allowed for statuses that have been locked. In an Autolog display, related 

data-entry fields are locked.   

Change the Status of a Production Event 

Method 1: 

1. Scroll to the column of the event to edit. 

2. From the Actions menu, click Edit <event name>. 

3. In the <event name> Information dialog box, on the General tab, select the desired status 

from the Status drop-down list. 

4. Click Apply. 

5. Click the Close button to close the dialog box. 

Method 2: 

In order to use this method, Status must be displayed as a column heading. Click here for 

more information. 

1. In the Autolog Display, scroll to the event whose status you want to change. 

2. Click the event's status. 

3. From the pop-up menu, click the status you want to change to. 

Adding a User-Defined Event 

You must configure a User-Defined Event (UDE) before you can add one in an Autolog or Sequence 

of Events (SOE) display. For more information, see Configuring User-Defined Events on a Production 

Unit. 

To add a user-defined event: 

1. Do one of the following: 
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o Add a new column in an Autolog UDE display. 

o Right-click an SOE event to add a UDE around it (in terms of time). 

2. Select Add User Defined Event. The Add User-Defined Events dialog box appears. 

3. On the General tab, do the following: 

a. Select the UDE from the Event Type list. 

b. In the Description box, type a brief description of the User-Defined Event. The 

description will be displayed in the list of events. This is step is optional. 

c. In the Status field, select a status. The default status that was selected when creating 

a UDE (refer to Creating a User-Defined Event is initially displayed. 

TIP:  If the Status field is locked and does not allow an entry, it means that a default 

status was not selected when creating a UDE. 

d. The Timestamp box is automatically filled with the timestamp of the event that you 

clicked in step 1. To insert the UDE at the current time, click Now. 

4. On the Cause tab, select a default cause for the user-defined event. 

5. On the Actions tab, select a default action for the user-defined event. 

6. On the Research tab, do the following: 

a. From the User list, select a user who is responsible for researching the user-defined 

event. 

b. From the Research Status list, choose either Open or Closed. 

c. Click Open Date to identify the date the case was opened. 

d. Click Close Date to identify the date the case was closed. 

7. Click the History tab to view a history of the event. 

8. Select OK to save the new user-defined event. 

Changing the Status of a User-Defined Event 

Follow these steps to change the status of a User-Defined Event in an Autolog display: 

In order to use this method, Status must be displayed as a column heading. Click here for 

more information. 

1. In the Autolog Display, scroll to the event whose status you want to change. 

2. Click the status of the event. 

3. From the pop-up menu, click the status you want to change to. 

User-Defined Event data may be locked based on the event status to prevent changes. Only 

transitions to other locked statuses are allowed for statuses that have been locked. In an Autolog 

display, related data-entry fields are locked. 
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Downtime Display 
Anatomy of a Downtime Display 

This information applies to the classic Downtime Display. 

Downtime displays are identified with the Downtime icon . A downtime display interacts with real-

time downtime information. It can show downtime for a single production unit (Unit mode), or it can 

show downtime for each unit within a production line (Line mode). 

Downtime events and reasons can be manually entered or automatically detected. You can also 

attach comments or documents to each event. 

Key elements of the display include the following: 

 Red rows indicate missing reasons. 

 Blue rows indicate the event has been split. 

 Green rows indicate the event is in progress. 

 Black rows indicate the event is complete and all the required information has been provided. 

 Downtime summaries are light yellow. 

 Downtime details are white and can be displayed by double-clicking on a summary row. 

 Downtime comments are shown in the Comment Window at the bottom of the display and are 

indicated by a pencil icon . 

Key Uses 

 Review automatically detected downtime events 

 Manually enter downtime details 

 Manually change downtime reasons 

 Add comments and attach documents to downtime events 

Key Information 

 Downtime start and end times 

 Downtime duration 

 Downtime cause location 

 Downtime fault 

 Downtime cause reasons 

 Downtime actions reasons 

 Downtime comments 

Changing Visible Columns in a Downtime Display 

This information applies to the classic Downtime Display. 

You can temporarily control the data that is displayed in a Downtime display by displaying or hiding 

columns. To specify which columns are displayed by default, you must open the Plant Applications 

Administrator and edit the column display options for the downtime display. 
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To temporarily view or hide columns: 

1. From the View menu, click Column Visibility. 

2. In the Change Column Visibility dialog box, do one or more of the following: 

o To display additional columns, under Hidden Columns, select the column(s) you 

want to display and click the Move Selected  button. 

To display all columns, click the Move All  button. 

o To hide columns, under Visible Columns, select the column(s) you want to hide and 

click the Remove Selected  button. 

To hide all columns, click the Remove All  button. 

3. Click the Close  button to close the dialog box. 

Change the Default Columns 

1. Open the Plant Applications Administrator. 

2. Expand Client Management. 

3. Expand Displays. 

4. Double-click the Downtime display. The Edit Display dialog box appears. 

5. Click the Display Options tab. 

6. Under Display Columns, for each of the columns you want to appear in your downtime 

display, click the Edit button. The Assign Property Value dialog box appears. 

7. Select True from the Value drop-down list. 

8. Click Ok. 

9. Click the Save button. 

10. Click Ok to reload the services. 

11. If your downtime display is open in the Plant Applications Client, you must close the display 

and re-open it to see your changes. 

Adding New Downtime Events 

This information applies to the classic Downtime Display. 

For information about inserting detail downtime events or splitting existing detail downtime events, 

see Inserting Detail Downtime Events. 

To add a new Downtime event: 

1. While viewing the Downtime display, do one of the following: 

o From the Actions menu, click Open New Event. 

o On the toolbar, click the Open New Event button. 

o Right-click on a row and select Open New Event from the pop-up menu. 

2. Click Yes to add the new downtime event. 

3. Enter the appropriate information for the downtime event. 
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Most information, such as Locations, Reasons, and Categories, can be selected from 

a drop-down list. 

Adding Comments to a Downtime Event 

This information applies to the classic Downtime Display. 

Adding comments is a great way to provide additional information. Comments can be either text that 

you type or a link to an external document, such as a Microsoft Word document. 

Keep in mind that if you paste a link to a document, the document cannot be moved to a different 

folder or directory; otherwise, the link will be broken and the document will not be found. 

To add comments to a downtime event 

1. Select the detail row. 

NOTE: If you can not see any detail rows, click the Expand All Events button. 

2. Right-click and click Add Comment from the pop-up menu. 

3. In the Comment window, type your comments or paste a link to an external file. 

4. Click the Save Comment button . 

INFORMATION: The pencil icon  on a row indicates that the event has a comment 

added. 

INFORMATION: To view comments, click the desired detail row and then click the pencil 

button  on the toolbar. 

Inserting Downtime Events 

This information applies to the classic Downtime Display. 

You can either insert a Downtime event or you can split single Downtime events into smaller time 

periods. The results are the same. 

To split Downtime event times: 

1. In the Downtime display, click the detail row where you want to insert a new detail event. 

If you do not see any detail rows, click the Expand All Events button. 

2. Do one of the following: 

o In the Downtime column, type the number of minutes in the first portion of the detail 

split. For example, to split a 17-minute downtime event into two events, the first one 

lasting 10 minutes and the second one lasting seven minutes, type 10 into the 

Downtime column. 

o In the Start Time column, type the start time of the second downtime event. For 

example, if the start time of a 17-minute downtime event is 06:24, and you type 

06:27, you'll split the 17-minute downtime event into two events. The first event will 

start at 06:24 and will be a three-minute downtime event. The second event will start 

at 06:27 and will be a 14-minute downtime event. 

o In the End Time column, type the end time of the second downtime event. For 

example, if the end time of the 17-minute downtime event is 06:41, and you type 

06:30, you'll split the 17-minute downtime event into two events: one six-minute 
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event and one 11-minute event. The first event will start and 06:24 and end at 06:30. 

The second event will start at 06:30 and end at 06:41. 

If you do not see these columns, see Changing Visible Columns. 

o Click the Insert New Event  button. 

Editing Downtime Events 

This information applies to the classic Downtime Display. 

You can change any of the information in a Downtime event. Be careful, though, when changing 

dates or times to avoid accidentally merging or splitting downtime events. 

To edit a Downtime event: 

1. While viewing a Downtime Display, select the desired detail row. 

2. Click the cell with the information you want to change. 

o If the information is a date, a start or end time, or the downtime minutes, type the new 

information. 

o Most other information can be changed by selecting a different option from a drop-

down list. 

Changing Date and Time Formats in Downtime Display 

This information applies to the classic Downtime Display. 

To change date or time formats: 

1. From the View menu, click Time Formats. The Select Time Format dialog box appears. 

2. Select the desired options. 

3. Click OK. 
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Downtime+ Display 
Anatomy of a Downtime+ Display 

NOTE:  Plant Applications 5.0 SIM 77, September 2012, introduced a new duration format in 

the Downtime+ display. To enable the format, you must add the DurationFormat node in the 

LocalSettings.xml file as follows: 

 

<!-- Two duration formats can be used in the Downtime + display: 0.0 (default) and hh:mm:ss. 

The second is manually added. --> 

<DurationFormat>hh:mm:ss</DurationFormat> 

The Downtime+ display enables plant floor operators to view and edit downtime events, using either a 

touch screen or keyboard for navigating the display. The Downtime+ display in touch screen mode 

highlights information as follows: 

 Red text indicates missing reasons. 

 Bold red text indicates the event has been split or that the event is grouped and that one or 

more detail record is not complete. Events are grouped when they share adjacent start and 

end times. 

 Bold blue text indicates the event has been split or that the event is grouped and that all 

detail records are complete. 

 Green text indicates the event is in progress. 

 Black text indicates the event is complete and all the required information has been provided. 

A Downtime+ screen includes these areas: 
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1 Click or tap Grid Actions to: 

 Manually create a downtime event, click or tap Insert Record. 

 Locate a downtime event within a time period, click or tap Go to Date. . The Date/Time Entry 

panel appears. 

 Hide (or view, if hidden) confirmed downtime events, click or tap Hide Confirmed. 

 Filter on selected columns, click or tap Build Advanced Filter. 

 Filter downtime events by length of downtime (duration), click or tap Duration Filter and use 

the slider. 

2 Click or tap Row Actions to: 

You must select a row to view or use Row Actions. 

 Expand or collapse grouped downtime events, click or tap Expand Group. Downtime events 

are grouped when there is no gap between the end-time of one event and the start-time of the 

next event. 

 Split the selected downtime event into two separate events, click or tap Split Record. The 

Split Value pane appears. 

 Delete the selected downtime event, click or tap Delete. 

 Copy and paste reasons, click or tap Copy Fault/Reasons. To copy and paste reasons, you 

must first view the downtime event details, then copy and paste the reasons. 

3 Click or tap a cell in the downtime event row to edit reasons, duration, and statuses. Based on the 

selected cell, the appropriate panel (4) appears. 

4 When you click or tap a row or a cell in a row, a panel appears with the appropriate data entry tools 

or selections. 

5 Click or tap Change Size Mode to change to or from touch screen mode. This button is visible only 

if the display option, Allow Mode Toggle, has been set to True by the Plant Applications Administrator. 

For information about the display options, see Configuring a Downtime+ Display. 

6 When you change to touch screen mode, the on-screen keyboard button appears. Click this button 

to use the on-screen keyboard. 

7 Select values easily by dragging the sliders. 

8 The time range of the downtime events is displayed at the top of the display. 

9 Use the scroll buttons to page through the events in increments that are equal to one-fourth the time 

specified by the Initial Windows Setting. 

Navigating the Downtime+ Display 

This information applies to the Downtime+ Display. 

To make selections in the Downtime+ display, you can click with a mouse or tap (using your finger or 

stylus). You can also use the arrow keys on your keyboard to make selections and move around the 

display. 

1. Click or tap a cell in the display or click or tap a row and use the arrow keys to select a cell. 

The appropriate panel is displayed. 

2. Press ENTER or tap the panel. The panel becomes active. 
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3. Tap the buttons or press the arrow keys to choose a button or select a box and use the 

keypad to enter a new value.  

Using Touchscreen Mode (Downtime+) 

This information applies to the Downtime+ Display. 

The Downtime+ display enables the use of a touch screen. To facilitate the use of a stylus or other 

tapping device, you can change the size of the text and buttons. You can also use an on-screen 

keyboard to enter text. The Change Size Mode button is visible only if the display option, Allow Mode 

Toggle, has been set to True by the Plant Applications Administrator. For information about the 

display options, see Configuring a Downtime+ Display. 

To enter touch screen mode: 

1. Click or tap the Grid Actions tab. 

 

2. Click Change Size Mode. The text and buttons become larger and the On-screen Keyboard 

button appears. 

 

3. Click the On-screen Keyboard button to open an on-screen keyboard. By default, Microsoft's 

On-Screen Keyboard is used.  
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4. Click Change Size Mode to exit touch screen mode. 

Editing Start and End Times (Downtime+) 

This information applies to the Downtime+ Display. 

Click or tap a cell in the Start Time or End Time column to display the Date/Time Entry tab where you 

can edit the selected time. 

To edit start and end times: 

1. Click or tap a cell in the Start Time or End Time column to display the Date/Time Entry 

panel. 

 

NOTE: You must click or tap the cell of a detail record and not a summary record. 

2. Click or tap one of the entry fields to adjust the value. Click or tap the arrows to change the 

value. 
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3. When an End Time cell is selected, the No Time toggle appears. To create an event with no 

end time (open record), slide the toggle to the right and then click OK. 

4. Slide the toggle to switch between AM and PM. 

5. Click or tap an entry field and then use the arrow buttons or slider to select a value. The scale 

of the slider changes automatically based on the selected entry field. 

6. Click or tap OK to save your changes or click or tap Cancel to cancel your changes. 

7. After you click or tap OK, you can click or tap Cancel Changes to cancel the changes that 

you have made. 

Editing Downtime Durations 

This information applies to the Downtime+ Display. 

There are two ways to edit the duration of a downtime event. 

 Edit the start time or end time 

 Edit the duration 

Editing the duration of the downtime event will adjust the end time of the event. Clicking or tapping a 

cell in the Duration column will display the Numeric Entry expander window where you can edit the 

duration. 

To edit the duration of a downtime event: 

1. Click or tap a cell in the Duration column. The Numeric Entry panel appears. 

 

You must click or tap the cell of a detail record and not a summary record. 

2. Click or tap in the Value box and use the keypad to enter a new duration value. 
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3. Click OK. 

Filtering Downtime+ Events 

This information applies to the Downtime+ Display. 

In the Downtime+ display, you can filter events by one or more of the values in a column. You can 

also filter confirmed events and filter events by duration (length of the downtime event). 

Filtering uses AND logic to determine the results that are returned. This means that the records that 

are returned must meet all the criteria you select. Consider the following records: 

Column 1 Column 2 Column 3 

A Red Square 

A Yellow Oval 

A Yellow Oval 

B Red Round 

If you selected A and B from Column 1 and Red from Column 2 and Oval from Column 3, no records 

would be returned because no single row matched all criteria. However, if you selected A and B from 

Column 1 and Red and Yellow from Column 2 and Square and Oval from Column 3, three records 

would be returned. 

NOTE: When you apply filtering, summary records are not displayed; however, the detail 

records belonging to the summary records will be displayed. 

To use the Advanced Filter: 

1. Click or tap Grid Actions. 
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2. Click or tap Build Advanced Filter. A message box appears. 

 

3. Click or tap Yes to start selecting what you want to filter on. The Build Advanced Filter 

becomes the Apply Advanced Filter button. 

4. Click or tap a value in a cell. A panel appears with the available choices. 
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5. Click or tap one or more of the choices and click the text "Click here to confirm selection." 

6. To filter by additional columns, click or tap another cell in a different column and select one or 

more of the available choices. Although you can make more than one selection per column, 

you can only select a column once. 

7. After you have selected all the values you want to filter on, click or tap Apply Advanced 

Filter. The downtime records are filtered and the Apply Advanced Filter button becomes the 

Clear Advanced Filter button. 

8. To clear the filter and display all of the downtime records, click or tap Clear Advanced Filter. 

To filter by downtime duration: 

1. Click or tap Grid Actions. 

 

2. Click or tap Duration Filter and drag the slider to the desired duration. Downtime events with 

a duration equal to or greater than the selected duration are displayed. 

3. Click or tap Duration Filter to display all downtime events. 

Show or hide confirmed downtime events: 

1. Click or tap Grid Actions. 
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2. Click or tap Hide Confirmed. Downtime events that have incomplete information (for 

example, no faults or reasons) are displayed. 

 

Confirmed events are those events that have a reason tree attached and all reason levels 

within the reason tree have been entered. 

3. Click or tap Hide Confirmed to display all downtime events within the specified window. 

Saving a Filter 

This information applies to the Downtime+ and Waste+ displays. 

You can save a filter in a Downtime+ or Waste+ display so that when the display is opened, by 

anyone, the saved filter is automatically applied. Additionally, if a new filter is applied to the display, 

the saved filter will be applied when the display is re-opened. 

The procedure to save a filter should be performed by an administrator or someone with advanced 

knowledge of Plant Applications. Furthermore, this procedure must be followed for each display for 

which you want to save a filter. 

Step 1: Modify LocalSettings.xml to Capture the Filter Information 

1. Locate LocalSettings.xml, which is located in the ..\Plant Applications\Client folder. 

2. Open LocalSettings.xml in Notepad or another text editor. 

3. Search for the element, PermitPersistenceStringLoad and change the value from false to 

true. 

4. Save and close LocalSettings.xml. 
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Step 2: Capture the Filter Information from the Display 

1. Open Plant Applications Client and open a Downtime+ or Waste+ display. 

2. Filter the information in the display. For information about applying filters, see the topic 

Filtering downtime events or Filtering waste events. 

3. With the filter applied, close the display and close Plant Applications Client. 

Step 3: Copy the Filter Information 

1. Locate LocalSettings.xml and open it in Notepad or another text editor. 

2. Search for the element, LastPersistenceData. 

3. Confirm that the value for DisplayType and SheetName match the display you just closed. 

4. Copy all tags and data, starting with <LastPersistenceData and including 

</LastPersistenceData>. Example: 

<LastPersistenceData DisplayType="Downtime+" SheetName="DT"> 

      <data> 

        <filters> 

          <filter type="advanced"> 

            <values column="Reason_Level1"> 

              <value>Not Scheduled</value> 

            </values> 

          </filter> 

        </filters> 

      </data> 

    </LastPersistenceData> 

5. Open a new document in your text editor and paste the copied information. 

6. Remove all line breaks and tab characters so that the text is all on one line. Example: 

<LastPersistenceData DisplayType="Downtime+" 
SheetName="DT"><data><filters><filter type="advanced"><values 
column="Reason_Level1"><value>Not 
Scheduled</value></values></filter></filters></data></LastPersistence
Data> 

7. Copy the single line. 

Step 4: Save the Filter Information in the Persistence String Display 
Option 

1. Open Plant Applications Administrator. 

2. Expand Client Management and expand Displays. 

3. Right-click the appropriate Downtime+ or Waste+ display and click Edit <display name>. The 

Edit Display dialog box appears. 

4. Click the Display Options tab. 

5. Under the Sheet Persistence heading, edit the Persistence String display option: 

a. Click the Edit button. The Assign Property Value dialog box appears. 

b. In the Value box, paste the single line you copied previously in Step 3: Copy the filter 

information. 

c. Click OK. 
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6. Save and close the Edit Display dialog box. 

NOTES: 

To temporarily clear the saved filter, click the Clear Advanced Filter button in the display. 

To change the saved filter, repeat all of the preceding steps. 

To remove the saved filter, remove the string from the Persistence String display option. 

Adding a Downtime Event 

This information applies to the Downtime+ Display. 

Downtime events can be manually added using the downtime display. 

To manually enter a downtime event: 

1. Click or tap Grid Actions. 

 

2. Click or tap Insert Record. An empty row (the working row) is added to the top of the rows of 

downtime events and the Data/Time Entry panel appears. 
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3. Enter the start date and time of the downtime event and click or tap OK. The start time is 

entered and the end time cell becomes active. 

4. Enter the end date and time of the downtime event. The cell to the right becomes active and 

the appropriate panel appears. 

5. Continue entering the downtime information. 

Finding Downtime Events 

This information applies to the Downtime+ Display. 

You can find downtime events within a specific time frame, which is defined by the Initial Windows 

Setting. The displayed downtime records are calculated as follows: 

(Start Time – Initial Windows Setting) to End Time. 

For example, if the Initial Windows Setting is 24 hours (the default) and the date entered on the 

Date/Time Entry expander window is Wednesday, November 28, 2007 3:30pm, all downtime records 

between Tuesday, November 27, 2007 3:30 PM and Wednesday, November 28, 2007 3:30 PM are 

displayed. If either end time falls within a downtime event, the downtime event is not included in the 

downtime events that are displayed. In this example, a downtime event that occurred on Tuesday, 

November 27, 2007 with a start time of 3:20 PM and an end time of 3:40 PM would not be displayed. 

To find downtime events: 

1. In the Downtime+ display, click or tap Grid Actions and click or tap Go to Date. The 

Date/Time Entry panel appears. 
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2. Enter the date and time and click OK. The downtime records within the defined window are 

displayed. 
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3. Use the  scroll buttons to page up or down in increments that are equal to one-fourth the 

time specified by the Initial Windows Setting, until the time range specified by the MAX 

display setting is reached, then it begins moving the start time and end time down in 

increments one-fourth the MAX time specified. 

Entering Comments to a Downtime+ Display 

Adding comments to a Downtime+ display is a useful way to provide additional information. 

Comments can be either text that you type or a link to an external document, such as a Microsoft 

Word document. 

Keep in mind that if you paste a link to a document, the document cannot be moved to a different 

folder or directory; otherwise, the link will be broken and the document will not be found. 

NOTE: Comments are categorized as either Reason, Action, or Research comments. All 

Reason comments are listed first in the Comments window. 

To add comments to a DT+ event: 

1. Select a row In the DT+ display, and select the Row Actions tab. 

 

2. Click the New Comment button or the Manage Comments button. 

3. In the Comments dialog that is displayed, select Reason, Action, or Research from the drop-

down menu. Type your comment in the box, which supports simple text with no formatting. 

You can also type URLs to documents and web sites. 
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4. Click or tap the Save button to save your comments. Downtime events with comments are 

indicated with the  icon, which is displayed beside the row item. 

Copying Faults and Reasons (Downtime+) 

This information applies to the Downtime+ Display. 

You can quickly enter or change faults and reasons for a downtime record. 

To copy faults and reasons: 

1. Select a downtime event. You can click or tap anywhere in the row. 

2. On the Row Actions tab, click or tap Copy Fault/Reasons. 
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T

 

3. Select the downtime event where you want to paste the faults and reasons. You can click or 

tap anywhere in the row. 

 

To select multiple rows, click the row header for the first row and drag to select additional 

rows. 

 

 

4. On the Row Actions tab, click or tap Paste Fault/Reasons. The fault and reasons are 

changed. 
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Genealogy View Display 
Anatomy of a Genealogy View Display 

This information applies to the Plant Applications Client program. 

The Genealogy View display is a real-time application used to load product from an input production 

unit or from multiple input production units on to an output or producing production unit.  Raw Material 

Events are put into Staged and Running positions and are consumed to make new 

products.  Relationships are created for the parent and children events. 

With the display, production event statuses can be updated manually by moving input events to the 

staged and running positions on an output or producing unit, completing an input event, creating a 

new production event on the output of the producing unit and unloading an incorrect staged event or 

incorrect running event.  

With the use of historian tag values as triggers, the automatic staging, running, completing, and 

consuming of events can occur. 

The display can filter for only valid input events based on specific production statuses and only valid 

input events based on the product being created on the producing unit. This filter can also use a Bill 

Of Material specification as well. 

The display allows for the review of: production event details (such as dimensions) for current, staged 

or historical events on the production unit, the status of an output or producing unit, the family tree 

identifying parent and child events for a production event, input history for a selected input position, 

current event running on an output or producing unit and the staged or next production events to be 

run.  If an Autolog display is associated with a production unit, it can be viewed within the Genealogy 

display for the selected event. 

Labels can be printed manually for a selected event or automatically if configured. 

Product based routing is achieved through a combination of the plant model, the execution path, and 

specifications. 

Parts of the Display 
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1. Listing of available production events that can be manually or automatically moved to the 

Staged (2) or Running (3) positions. 

2. The staged position. 

3. The running position. 

4. The first box on the left (the red one), indicates the number of High alarms. The second box 

from the left indicates the number of Medium alarms. The third box from the left indicates the 

number of Low alarms. The box on the right (the green one) indicates if the unit is running or 

is down, as defined by the downtime configuration, and also will display the number of 

downtime events on the unit for the current production day. 

5. The unit view represents the producing unit and displays the current production, the number 

of downtime minutes and production for the day, as defined by the Data Range display option. 

6. The events that were created. Use the scroll bar to move through the list of events. 

7. Use the drop-down list to select a different unit. 

Terms 

Running: Running generally means that an item is being consumed on the unit. It does not 

necessarily mean that it is only this unit on which an item is being, or has been, consumed. Unloading 

from the running stage generally means that an item has been partially consumed. 

Staged: An item in the staged position means that it is ready to be run. Unloading from the staged 

position generally means that an item has not been consumed and is being returned to inventory. 

Uses 

 Move Input Events to the Staged and Running positions on an Output or Producing Unit. 

 Manually Complete an Input Event. 

 Manually create a new Production Event on the output of the Producing Unit. 

 Manually Unload an incorrect Staged Event or incorrect Running Event. 

 Automatic Staging, Running, Completing, and Consuming of Events based on Historian Tag 

values. 

 Filter to display only valid Input Events based on specific Production Statuses. 

 Filter to display only valid Input Events based on Product being created on the Producing 

Unit. 

 Modify or View Current Event Running on an Output or Producing Unit. 

 Review Production Event Details such as dimensions. 

 Provide an Overview of the Status of an Output or Producing Unit. 

 View the Family Tree for a Production Event. 

 Update the Production Status of a Production Event. 

 View the Input History for a selected Input position. 

 Print Labels for the selected Event. 

 Set up automatic label printing. 

Key Data 

 Display a filtered inventory listing of all Events that are available to run on the Producing Unit. 
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 View Autolog display data associated with the Event. 

 Time, Product, and Status/Routing Of Production Events. 

 Current Running Event on an Output or Producing Unit. 

 View Staged or Next Production Events to be Run. 

 View Production Event Details for Current Running Event, for the Staged Production Event, 

and for Historical Production Events on that Production Unit. 

 Family Tree displays all Parent and Child Events for a selected Event. 

  Key performance statistics can be viewed for the Producing Unit such as: Downtime, 

Efficiency, Waste, Alarms, and Process Orders. 

Functions in the Genealogy View 

Most, if not all, of the functions in Genealogy View are available by right-clicking on an object, which 

will display a menu with various options specific to the selected object. Many of the functions that you 

will use most often can also be accessed by clicking an icon on the toolbar. 

Displaying the Inventory List 

The Genealogy View inventory list displays the current list of events that are available to be loaded 

into the input positions on a producing unit.   

To display the inventory list: 

1. On the input for which you want to display the available inputs, do one of the following: 

o Click to select an empty staged or running position, right-click the selected input 

position, and select Load Inventory. 

 

--OR-- 

o Click to select either a staged or running position and click the  Load Inventory 

icon from the toolbar. 

The inventory list for selected input will be displayed. If you have multiple inputs, the inventory list 

automatically refreshes and lists the available events for the selected input. 

NOTE: You can sort the Inventory List by clicking the column heading for the column you 

wish to sort the list by. 

Configuring the Inventory List 

You can sort the inventory list and determine which columns to display. 

To configure the inventory list: 

1. Display the inventory list. 

2. Right-click anywhere in the inventory list and select Manage Columns. The Display Options 

dialog box appears. 

3. To display columns, select the column from the Hidden list and move it to the Visible list. To 

hide a column, select the column and move it to the Hidden list. 

4. To sort columns, use the drop-down lists in the Sort Order section to control how the columns 

are sorted. To temporarily sort the inventory list, you can click on a specific column heading 

5. Click the Close [X] button to save your changes and close the dialog box. 
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Manually Moving an Event from Inventory 

The inventory list displays the current list of events available to be staged or run on the producing 

unit. You can manually move an event from the inventory list to either the running position or the 

staged position. 

To manually move an event from inventory: 

1. Display the inventory list. 

2. Drag the selected event to either the desired staged or running position. 

Staging an Event by Scanning a Barcode 

The inventory list shows the current list of events available to be staged or run on the producing 

unit.  A barcode label can be read if it corresponds to an event number in the inventory list. 

To stage an event by scanning a barcode: 

1. Display the inventory list. 

2. Scan the barcode. The Event Number is displayed in the selected position. An Event can be 

placed directly into the Running Position if there is not an event currently in that position. 

Manually Completing a Running Event 

A running event is the current event being made on the producing unit. 

To manually complete a running event: 

1. Select the running input position. The running box is highlighted. 

2. Right-click and select Complete [Event Number]. The event is then completed and the 

status is changed, depending on how the Status for Completed running events display option 

has been configured (the default is "consumed"). An event in the staged position is 

automatically moved into the running position. 

Manually Unloading a Running Event 

A running event is the current event being made on the producing unit. If this is the incorrect event, it 

must be unloaded from the running position, which will move it back into inventory. 

To manually unload a running event: 

1. Click the event in the running position that you want to unload. 

2. Right-click and select Unload [Event Number]. The event is then removed from the running 

position and placed back into inventory. 

Manually Moving a Staged Event to the Running Position 

A staged event is automatically moved to the running position when an event in the running position is 

completed. However, if there is no running event, then an event can be moved from staged to 

running. 

To manually move a staged event to the running position: 

1. Select the Staged input position.  The staged box will be highlighted. 

2. Right-click and select Move [Event Number] to Running. The staged event is then moved 

into the running position. 
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Manually Unloading a Staged Event 

If the incorrect event is in the staged position, it must be unloaded and moved back into inventory. 

To unload a staged event: 

1. Click on the event in the staged position. 

2. Right-click and select Unload [Event Number]. The event is then removed from the staged 

position and placed back into inventory. 

Changing the Status of an Event 

The status of an event indicates the current state of a production event. If you have configured the 

Allow status changes on inputs and Allow status changes on outputs display options to allow 

status changes, you can manually change the status of an event. 

To change an event status: 

1. Select the staged, running, or output event. The selected box will be highlighted. 

2. Right-click and select [Production event] Status. 

3. Select the appropriate event status from the list of available status events. 

Viewing the Input History for an Input 

The input history displays the events that have been loaded or unloaded from the staged or running 

position on a particular input. 

To view the input history for a single input: 

1. Select the staged or running events position inside the selected raw material input. The 

selected box will be highlighted. 

2. Right-click, point to Actions, and select View Input History. The Input History dialog box 

appears, listing the history for the specific raw material input for the previous 24 hours. 

To view the input history for all inputs: 

 Right-click any empty portion of the Genealogy View, point to Actions, and select View Input 

History. The Input History dialog box appears, listing the input history for all raw material 

inputs. 

Viewing the Event Details for an Event 

The event details displays detailed information for the selected event. Depending on which of the two 

methods used to view the details, you may be able to edit the: 

 Event number 

 Event status 

 Start time and end time 

 Comments 

To view the event details for an event: 

Do one of the following: 

1. In an empty area of the display, right-click, point to Actions, and select View Details. There 

will be a check mark next to View Details. 
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2. Click an inventory, staged, running, or output event. The Event Details box appears. 

--OR-- 

1. Click an inventory, staged, running, or output event. 

2. Right-click and select Edit [Event Type] Properties. A dialog box appears with five tabs. On 

the General tab, you can edit the: 

o Event number 

o Event status 

o Start time and end time 

o Comments 

Additionally, you can view genealogy, related events, and event history information for the 

selected event. 

NOTE: To turn off viewing details, in an empty area of the display, right-click, point to 

Actions, and select View Details. The check mark is removed. 

Viewing the Family Tree for an Event 

The View Family Tree option displays the parent and child events for the selected event. 

To view the family tree for an event: 

1. Select the staged, running, or output event position. The selected box will be highlighted. 

2. Right-click and select View Family Tree. The view changes to Tree View. 

3. To view the Family Tree for any specific Production Event, double click on that event. 

4. To return to the Genealogy Unit View click on the white space, right click and select View 

Genealogy Unit. 

Viewing Production Event Data for an Event 

The View Events option allows production event data to be displayed for the selected event. An 

Autolog is displayed in the right hand window pane. For this option to work, you must either: 

 Assign the Production Event Autolog display to the Genealogy View on the Genealogy Data 

tab when configuring the Genealogy View in the Plant Applications Administrator. For more 

information, see the topic Creating and Configuring the Genealogy View Display. 

 Select the Default Genealogy Display option on the General tab of the Autolog display. 

To view the production even data for an event: 

1. Right-click on a blank area, point to Actions and select View Events. A checkmark is 

displayed next to the View Events option. 

2. Click an event in the staged, running, or output position or in the inventory list. An Autolog is 

opened in the lower right-hand corner displayed the selected event data. 

3. To close detailed data window, right-click on a blank area, point to Actions and select View 

Events. The checkmark next to the View Events option is removed. 

Viewing Event Information from the Family Tree for an Event 

The View Event Details option allows production event information to be displayed for the selected 

event in the Tree View. 

To view the event details for an event: 
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1. Select the staged, running, or output events position.  The box selected will be highlighted. 

2. Right click and choose View Family Tree from the menu. 

3. Right click and select Show (Event Type) Detail Window from the menu. 

4. An Event Details will open up in the upper left portion of the display. 

5. To close the Event Details window, right click and select Hide (Event Type) Data from the 

menu. 

Viewing the Production Schedule 

The production schedule is used to display the current production schedule and the status of the 

current active process order.  The currently active process order is used to track the actual quantity 

produced against a process order and its planned quantity, planned start time and planned end 

time.  The production schedule allows process orders to be reordered and edited. 

To view the production schedule: 

1. Right-click on a blank area of the Genealogy View, point to Actions and select View 

Production Schedule. A Schedule View display will open if it is available for the current 

production unit. For more information on the Schedule View display, see the topic Creating 

and Configuring the Schedule View Display. 

2. To close the Schedule View window, click on the x in the upper right hand corner. 

Viewing the Pattern Details for the Producing Unit 

If activated, process orders can contain setup patterns that are specific to an individual process order. 

Setup patterns detail the dimensions a product is to be manufactured to for a specific order. The View 

Pattern Details option displays the current pattern details in the output event positions for the unit, if it 

exists. 

To view the pattern details for the producing unit: 

 Right click on a blank area of the Genealogy View, point to Actions, and select View Pattern 

Details. The current pattern details are displayed in the output event. 

Viewing Comments for an Event 

The Add Comments option displays any comments associated with the selected event. If an event 

has a comment attached, there will be a black triangle located in the upper left hand corner of the 

event box. 

To view comments for an event: 

1. Right-click on a blank area of the Genealogy View, point to Actions and then click View 

Comments. The comments window will open at the bottom of the display 

2. Select the desired event. 

3. If comments exist for the event they will be displayed.  New comments can be added in the 

comment window by clicking in the comment window and typing in your comment. 

Printing a Label for an Event 

The Print Label option allows a label to be printed for the selected event, if that option is available and 

configured. The label printing executable program called is defined by the Filename For Auto Labeling 

display option. For more information, see the topic Genealogy View Display Options. 
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To Print A Label for An Event: 

1. Select an event from the staged, running, or output positions. 

2. Right-click and choose Print Label for [EventNumber]. 

Changing Display Options for All Events 

The Display Options allows toggling the one additional piece of data that is shown in an Event Box in 

addition to the Event Number. 

To Change Display Options for All Events: 

1. Right click on a blank area of the Genealogy View to display a menu. 

2. Choose Display Options. 

3. Select from the following: 

o Process Order 

o Customer Order 

o Diameter 

o Weight 

o Length 

o Width 

Using the Zoom Feature 

The Zoom feature allows enlarging or shrinking of the Genealogy View display components. 

To use the Zoom feature: 

 Right click on a blank area of the Genealogy View, point to Zoom and select one of the 

following: 

o Zoom In 

o Zoom Out 

o Clear Zoom 

Changing Unit Details Data 

The Change Unit Details option allows changes to what is shown in the middle of the Producing Units 

data box. This allows current production and efficiency numbers to be shown. 

To Change Unit Details: 

1. Right-click anywhere in and select Unit Display Options. The Display Options dialog box 

appears. 

2. From the Display Options window move the Hidden data options and the Visible options 

using the > < buttons. 

The following options are available:  View Unit Production Rate, View Unit Production Rate Percent, 

View Unit Production Good Items, View Process Order, View Alarm Counts, View Product Code, View 

Production Amount, View Production Total Items, View Downtime Minutes, View DownTime Percent, 

View Waste Minutes, View Waste Percent, View Waste Amount, View Efficiency Percent, View 

Inventory Total Items, View Unit Production Rate Percent. 

Changing Unit Time Frame 
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The Time Frame option determines when the event count in the production unit box will be reset. The 

default is determined by the Date Range option, which is specified when configuring the Genealogy 

View display in the Plant Applications Administrator. For more information, see the topic, Genealogy 

View Display Options. 

The three options are: 

 Day To Date: Selecting Day To Date will reset the event count at the start of your production 

day, which is defined by the EndOfDayHour and EndOfDayMinute site parameters. For 

information on these two site parameters, see the topics, Editing EndOfDayHour Site 

Parameter and Editing EndOfDayMinute Site Parameter. 

 Rolling 24 Hour: Selecting Rolling 24 Hour will show the event count for the past 24 hours. 

 Shift To Date: Selecting Shift To Date will reset the event count each time there is a shift 

change. For more information about shifts and crew schedules, see the topic, Administering 

Crew Schedules. 

To change the unit time frame: 

 Right click on a blank area of the Genealogy View, point to Time Frame and select one of the 

following: 

o Day To Date 

o Shift To Date 

o Rolling 24 Hour 

Saving Locations of the Input Positions 

You can save your view configurations by using the Save Positions command in the Genealogy View 

display. For example, you can click and drag the raw material input boxes, open the Inventory window 

or an Autolog display, save the position and when you re-open the Genealogy View, everything will be 

the same as when you closed it. 

To save locations of the input positions: 

 Right click on a blank area of the Genealogy View and select Save Positions. 

NOTE: You must click the  Load Inventory icon to refresh the Inventory window. 
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Non-Productive Time Management 
(Client) 
Anatomy of a Non-Productive Time (NPT) View Display 

The Non-Productive Time View accessed as a client display is used to manage Non-Productive Time 

(NPT). 

NOTE:  If no security has been assigned to this display, all users will have Manager 

access to the display. If a security group has been assigned, a user must have a minimum 

of Read/Write access to the security group to perform all of the tasks in the display. For 

more information, see Display Security. 

In the Non-Productive Time View accessed as a client display, you can: 

 Schedule Non-Productive Time 

 Edit Non-Productive Time 

 Copy Scheduled Non-Productive Time 

 Delete Scheduled Non-Productive Time 

The display offers the following features: 

TIP:  The Data Window Display under the tool bar is removed from Plant Applications 6.1, 6.2, and 

later versions. It is replaced with a Search feature to go to the desired starting time and date. Thirty 

days of data before and after the starting date is loaded and is refreshed as you move through the 

calendar. 
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Non-Productive Time View tool bar 

 

Production Unit list. If there is only one production unit on the display, the Production Unit 
list is not displayed. 

 

Non-Productive Time calendar 

 

Comment box 

Non-Productive Time View Tool Bar 

 

 

Click the Show All button to show all production units in the list. 

 

Click the Show Selected button to show only the selected production units. 

 

Click the Go button to retrieve non-productive time data for the selected production units. 

In the Plant Applications 6.2, August 2014 SIM, data is resynchronized automatically when 

you go forward or backward a week or a month. 

 

Click the Select All button to select all production units in the list. 

 

Click the Deselect All button to clear all the selections in the production list. 

 

Click the Show/Hide button to show or hide the production unit list. 

 

Click the Comments button to show or hide comments. 

 

Click the Set Time button to determine the starting point to display 30 days 

of data before or after the starting point. 

 

Click the Day button to change the calendar to Day view. 

 

Click the Work Week button to change the calendar to Work Week view. 

 

Click the Week button to change the calendar to Week view. 

 

Click the Month button to change the calendar to Month view. 

 

Click the Current Time button to go to the current day, week, or month. 

 

Click the Go To First button to go to the first non-productive time entry. 
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Click the Go To Last button to go to the last non-productive time entry. 

Calendar Time Scale 

When you switch the Non-productive Time View to a  single day or  five-day work week view, 

a time scale becomes visible. This time scale determines the default duration for entries in the 

calendar. By default, the time scale is set to 30-minute increments. 

Change the Time Scale 

1. If necessary, change the calendar view to  single day or  five-day work week view. 

2. Right-click the time scale and select the time increments for the calendar. 

When you schedule non-productive time, the time scale also determines how the non-productive time 

is displayed. For example, if the time increment is 15 minutes, then the non-productive time will span 

the nearest 15 minute intervals in the calendar grid. A non-productive time of 14:50 to 15:20 would 

span 14:45 to 15:30. However, the time displayed in the cell will be accurate. 

Scheduling Non-Productive Time from 14:50 to 15:20 

 

Result 

 

Cell is to nearest 15 minute increments. In this example, 2:45 - 3:30 
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Actual time is displayed in the cell. 

Lines indicate actual time span. 

Scheduling Non-Productive Time 

This task applies to the Non-Productive Time View (client) display. To manage non-productive time 

through the Plant Applications Administrator program, see Non-Productive Time (Administrator). 

Non-Productive Time client displays are identified with . 

Schedule Non-Productive Time 

1. In the Plant Applications Client program, open the Non-Productive Time View display. 

2. If necessary, select the production unit on which you want to schedule non-productive time 

from the Production Unit list. If only one production unit has been configured for this display, 

the Production Unit list will not be visible. 

NOTE: If there are no production units in the list, click Show All. 

3. In the calendar, double-click the day and time you want to schedule as non-productive time, 

or right-click a cell and select New, to display the New Non-Productive Time dialog. 

4. Configure non-productive time by selecting a unit, time frame, and reason. When 

finished, click OK. 

Editing Non-Productive Time 

This task applies to the Non-Productive Time View (client) display. To manage non-productive time 

through the Plant Applications Administrator program, see Non-Productive Time (NPT). 

There are three ways to edit non-productive time. 

 If you want to change the date of the non-productive time, drag the non-productive time to the 

new date on the calendar. 

 If you want to adjust the time frame, drag a start or end time to resize the non-productive time 

cell. 

NOTE:  Starting with the Plant Applications 6.2 August 2014 SIM, you can drag NPT 

boundaries to change time ranges. Adjacent or overlapping NPT events are automatically 

adjusted or removed. NPT events can now be adjoining (the end time of one event can be 

the same as the start time for a second event).  

 If you want to change reasons, you must edit the non-productive time. 

Edit Non-Productive Time 

1. In the Plant Applications Client program, open the Non-Productive Time View display. 

2. To view the scheduled non-productive time for a production unit, select the production unit in 

the Production Unit list. By default, all production units are selected. 

3. Double-click the non-productive time in the calendar you want to edit, or right-click the non-

productive time to open the Edit Non-Productive Time dialog for making changes. You can 

also drag the start or end time of an event to make a change. 
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Copying Non-Productive Time (NPT) 

This task applies to the Non-Productive Time View (client) display. To manage non-productive time 

through the Plant Applications Administrator program, see Non-Productive Time. 

Once you have scheduled Non-Productive Time (NPT) on a particular day, you can copy the existing 

NPT and paste it onto another day. 

Copy a Scheduled Non-Productive Time 

1. In the Plant Applications Client program, open the Non-Productive Time View display. 

2. In the NPT View, right-click on the scheduled non-productive time, and choose Copy. 

3. Right-click the day you want to schedule NPT, and choose Paste. The new NPT will be 

scheduled for the new day but within the time frame of the NPT you copied. 

4. Repeat step 3 on each day you want to schedule NPT. 

Deleting Non-Productive Time 

This task applies to the Non-Productive Time View (client) display. To manage non-productive time 

through the Plant Applications Administrator program, see Non-Productive Time. 

Delete Non-Productive Time 

1. In the Plant Applications Client program, open the Non-Productive Time View display. 

2. In the Non-Productive Time View, right-click the scheduled non-productive time and choose 

Delete (or click the non-productive time and press the Delete key). A message appears 

asking you to confirm the deletion. 

3. Click Yes to delete the non-productive time. 

Troubleshooting 

Meaning of the Gray and Green Calendar Box 

When you move a non-productive time to another time or day, the original position will turn gray and 

the new position will turn green to indicate that a request is pending. After the request has been 

processed, the new position will turn white. 

On occasion, it may appear that the Router service is not processing the request. This may be an 

issue with caching. To clear the cache, click the Go button. 
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Production Overview Display 
Anatomy of a Production Overview Display 

The Production Overview display is a real-time application used to show data specific to the 

performance of each Production Unit on a Line. There are four different views available for the 

Production Overview. 

 Production Execution Path View 

 Units View 

 Alarms View 

 Icons View 

Uses 

Provide data for each Production Unit in a Production Line. The following data is available for 

display:  the Product, Production Amount, Alarm Count, Downtime Minutes, Waste Amount, Process 

Order, Production Rate, Downtime Efficiency, Waste Efficiency, and the Overall Efficiency for the 

current production day. Double-Clicking a value will also display the detail data for that value. High, 

Medium, and Low Alarm Counts are shown in the small boxes above the data and the 4th small box 

indicates if the Unit is Running or Not as defined by the Downtime configuration. The Number of 

Downtime Events is displayed in this box for the current production day. The number of events in 

Inventory between Units is shown in the Inventory Box. 

Key Data 

The following data is available for display: 

  Alarm Counts 

 Product Code 

 Process Order 

 Production Rate 

 Production Amount 

 Production Quality 

 Downtime Minutes 

 Waste Amount 

 Overall Efficiency 

 Detail data for each value is accessible 
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Production Run Analyst Display 
Anatomy of a Production Run Analyst (Operator) Display 

Production Run Analyst Displays are identified with the Production Run Analyst icon . The 

Production Run Analyst Display, formerly known as the Operator Display, is designed for reviewing 

current process and quality conditions versus standard (recipe) conditions and historical conditions. It 

provides historical statistics for quality and process data. 

The display provides a convenient method for comparing current conditions to current or other recipe 

targets. Historical production run averages and control statistics can be reviewed by right-clicking on a 

cell for a particular variable and product combination. Product specifications are displayed, and 

operating procedures can be attached. 

 Variables are underlined if comments are attached. 

 Targets for the current product are displayed in a column. 

 Current real-time values are displayed in the Current column 

 Ad ho Summary columns are added to the right of the Current column. 

 Summary statistics are shown by right-clicking a cell. 

 Specifications for the selected cell are displayed at the bottom of the Display. 

Key Uses 

 Compare current conditions to current recipe targets 

 Compare current conditions to other recipe targets 

 Review historical production run averages 

 Review historical production run control statistics 

 Compare current conditions to previously captured data sets 

 Review product, product specifications, and operating procedures 

Key Data 

 Summarize quality and process data 

 Results of calculations 

 Product specifications / recipes 

 Historical statistics for quality and process data 

Inserting Historical Run Summaries 

In the Production Run Analyst display, you have three options for inserting historical run summaries. 

 Insert the last production run 

 Insert the last three production runs 

 Search and select from all production runs 

Insert the Last Production Run Summary 
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 From the Actions menu, select Insert Last Production Run. 

Insert the Last Three Production Run Summaries 

 From the Actions menu, select Insert Last 3 Production Runs. 

Search and Select a Run Summary from All Production Runs 

1. From the Actions menu, click Query For Production Runs. 

2. The Plant Applications Run Summary Query wizard will start. In the first page, do one of the 

following: 

a. To search for an existing query, in the Search Queries Named box, type the name, 

or partial name, of the query you want to run and click Search. If you don't know the 

name, leave the box empty and click Search to retrieve a list of all saved queries. 

Then, click Next. 

b. If you have no saved queries, click Next. 

3. On the second page of the wizard, select the product or products you want to include as part 

of the query. 

4. On the third page of the wizard, define one or more criteria you want to use for the query. As 

you define criteria, click Add. 

You must add at least one criteria if you want to save the query for future use. 

5. On the fourth page of the wizard, you can review a summary of the criteria you've defined for 

the query. Click Execute Query. When the Query Status displays "Query Complete," click 

Next. 

6. On the fifth page, select the run summaries you want to include on your display by clicking the 

box next to No. Then, click Next. 

7. On the sixth page, do the following: 

a. To save the query, type the name of the query in the Save Query Name As box and 

click Save. 

b. Click Finish to add the run summaries to your display. 

Inserting Product Specifications in a Production Run 

Analyst Display 

Inserting production specifications, or targets, allows you to compare current real-time values to 

specifications. 

Insert Product Specifications 

1. From the Actions menu, click Insert New Product Specifications. 

2. In the Insert Product Specifications dialog box, do the following: 

a. Select a product group from the Product Group drop-down list. 

b. Under Products, select a product. 

3. Click OK. 
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Viewing Historical Statistics in a Production Run Analyst 

Display 

View Historical Statistics 

Do one or more of the following: 

o To see production run statistics, right-click a Summary column heading. 

o To see summary, scroll to a particular cell and right-click to see summary statistics for 

a variable and production run. 
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Relative View Display 
Anatomy of a Relative View Display 

This display is available only if you have purchased an Efficiency or Quality license. Refer to 

Contact Information. 

The Relative View display is a real-time application designed to compare a series of variables to 

product-based specification or recipe limits. Values are plotted according to the relative distance 

between the current value and its specification limits. If specification limits are not available, values 

are plotted against historical statistics for the current product. The display offers these features: 

 Current value relative to product specifications shown with a colored bar 

 Previous values shown with non-colored bars around current value 

 Plus or minus trend indicator 

o (+) = Getting better 

o (-) = Getting worse 

 Target line is shown in the middle 

 Warning limits and reject limits are shown above and below the targets 

 Variable descriptions are shown at the bottom. 

Key Uses 

 Compare current values of several variables against specifications 

 Access historical trends by drilling down into a specific variable 

Key Data 

 Summarized quality and process data 

 Product specifications / recipe limits 
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Schedule View Display 
Anatomy of a Schedule View Display 

Use a Schedule View display to view and execute the current production schedule. Active process 

orders track actual production and quantities against process orders, and display remaining 

quantities, planned quantities, planned start times, and planned end times. You can reorder, change 

the status of, and edit process orders, and the production schedule provides normal, warning, and 

alarm indicators to aid in tracking progress. Refer to Schedule Display Process Order Grid for 

additional information. 

Sort Order 

By default, process orders are sorted by schedule status, then implied sequence (descending), and 

then forecast start date. You can control the sort order when you configure the production execution 

path. For more information, see Defining Execution Paths. 

Setup Patterns 

Process orders may contain setup patterns, which are details of the dimensions to which products are 

manufactured for specific process orders. Setup patterns display status (which can be changed), 

planned and actual quantities for all patterns within a process order, as well as normal, warning, and 

alarm indicators. Setup patterns can be reordered and edited. 

In a Schedule View display, you can view customer orders and the item details associated with them. 

Uses of a Schedule View 

 See an overview of the active process order 

 Create, schedule, and reorder process orders 

 Associate bills of materials to process orders 

 Edit process orders 

 Change the status of process orders 

 Bind and unbind a process order from a specific path 

 Select the currently active process order against which production is counted 

 Track progress of process orders by quantity or time 

 Provide setup patterns to aid in the manufacturing of dimensional products 

 View customizable normal, warning, and alarm indicators. 

Key Data 

 Planned, actual, and remaining quantities for each order 

 Planned start and planned end times for each order 

 Normal, warning, and alarm indicators 

 Process orders are listed in order of execution 

Adding a New Process Order 
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The Process Order appears in the Production Schedule View when a time frame containing the 

specified Process Order's projected Start Time is set.  All information specified when adding the 

Process Order is preserved throughout the Schedule View. 

Add a New Process Order Manually 

1. Select Add New Process Order from the Actions menu, or click the Add New Process 

Order tool icon, or in the Process Order Actions hyperlink category, click the Add New 

Process Order hyperlink, or right-click on a Process Order in any column except the Path or 

Status column and select Add New Process Order. 

2. From the Add Process Order window the following are required entries: 

o A new unique Process Order Number is required for each Order. 

o Select a Control Type of Quantity, Duration, or Time. 

o Select a Product for the Process Order. 

o Enter a Start Time or select the drop down arrow to initiate a calendar. 

o Check whether an end time will be used to complete the running of the order at the 

specified time. 

o Enter a Planned Quantity for the Process Order. 

3. Select the Advanced tab and specify any desired information. Parameters for additional user-

defined data relevant to a site are defined in the Advanced tab: 

o User General 1 – describes additional, user-specific data about a Process Order. 

o User General 2 – describes additional, user-specific data about a Process Order. 

o User General 3 – describes additional, user-specific data about a Process Order. 

o Info – describes extended, user-specific information about a Process Order. 

o Block Number – defines an identifier that signifies a collection of as many as 10 

Process Orders. 

o Production Rate – describes a target Production Rate for the specified product that is 

manufactured according to the Process Order. 

4. Click the Save button. 

When you associate a bill of materials formulation with a process order, only the 

formulations associated with the selected product will be available for selection. 

Adding Comments to a Process Order 

In the Schedule View, comments can be added to a specific Process Order if security allows it. 

Add Comments to a Process Order 

1. Select View (Process Order) Comment from the View menu, or click the View Process 

Order Comment tool icon, or in the Process Order Actions hyperlink category on the right, 

click the View Process Order Comment hyperlink, or right-click on a Process Order in any 

column except the Path or Status column and select View Process Order Comment. In the 

Comment For Process Order window, click the New Comment button.  In the text area, type 

the desired comment. Click the Save Comment button. 

2. The Comment For Process Order: (Process Order) window is displayed. In the text area, 

type the desired comment. 

3. Click [x] to close the Comment For Process Order: (Process Order) window when 

completed. 

Activating a Process Order 
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In the Schedule View, the Active Process Order is indicated by a Status of Active.  The currently 

Active Process Order is used to track the Actual Quantity produced against a Process Order and its 

Planned Quantity.  Activating a Process Order makes it the current running Process Order that 

product quantities, Process Order run times, and Process Order statistics are applied to. 

Activate a Pending Process Order 

1. Select the Status hyperlink Change (Process Order) To Next from the Process Order Status 

hyperlink category, or right-click on a Process Order in the Status column and select the 

Status of Next. 

2. If the current Status is Pending, then select Next. 

3. Select Yes to Change Process Order [Process Order] From Pending to Next. 

4. If the current Status Next, then select Active. 

5. Select Yes to Change Process Order [Process Order] From Next to Active. 

Advancing a Process Order 

Within the Schedule View display, you can manually move an active process order to any production 

unit that is part of the production execution path. Keep in mind that the process order must have a 

status of Active before it can be advanced to another production unit. 

Before you can manually advance a process order, the Schedule Control Type needs to be set to 

Schedule Flows Independently on the General tab of the Execution Path Configuration dialog 

box in the Plant Applications Administrator. 

Advance and Edit a Process Order 

1. In the Schedule View display, select a process order with a status of Active and do one of the 

following: 

o Right-click and click Edit Starts for <process order name>. 

o In the HyperLinks menu, under Process Order Actions, click Edit Starts for <process 

order name>. 

o Click the Edit Starts for Process Order icon  on the toolbar. 

o On the Actions menu, click Edit Starts for <process order name>. 

2. In the Edit Starts for Schedule dialog box, click the Advance button. 

3. In the Edit Starts for Schedule Unit Selection dialog box, select the production unit you 

want to advance the process order to and click the OK button. 

4. To close the process order on a production unit, right-click the production unit and click 

Close. This will enter an end time for the production run on the selected production unit. 

5. To open a process order on a production unit, right-click the production unit and click Open. 

This will enter a start time for the production run on the selected production unit. 

6. To delete a process order on a production unit, right-click the production unit and click Delete, 

then click Yes to confirm the deletion. 

7. To edit the run times on a production unit, right-click the production unit, click Edit and then 

do the following: 

a. In the Advance Schedule Edit Run Times dialog box, enter the new start time. You 

cannot move the start time beyond the start time of the scheduling unit. 
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b. To edit the end time, select the End Time check box and enter the new end time. 

You cannot move the end time beyond either the end time of the scheduling unit or 

the current time. 

c. Click the Save button. 

Please note the following limitations when editing run times: 

o The end time cannot exceed the current process order's actual end time 

or the actual start time of the next process order. 

o The start time cannot go beyond the start time on the scheduling unit. 

o If you stop and then re-start a process order on a unit, and the start time 

of the second record is before the end time of the first record, the start 

time of the second record becomes the end time of the first record. 

 

o If you stop and then re-start a process order on a unit and then change 

the end time of the first record to go beyond the end time of the second 

record, the two records will be merged. 

 

o If you stop and then re-start a process order on a unit and then change 

the end time of the first record to go between the start time and end time 

of the second record, the end time of the first record becomes the start 

time of the second record. 
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Binding a Process Order to a Path 

In the Schedule View, the selected Process Order is Bound to a Path.  If the Display Unbound 

Process Orders display option is set to True (this value is set in the Display Options from the 

Administrator), the unbound Process Orders are displayed below all Path-bound process orders, with 

no information displayed in the Path column. 

Bind a Process Order to a Path 

1. Select the Bind (Process Order) to (Path) hyperlink from the Process Order Actions 

hyperlink category. 

2. Click Yes to confirm. 

Changing a Process Order Status 

In the Schedule View display, only Valid Transitions appear in the hyperlink and right-click menus for 

the selected Process Order. If the limit of Process Orders on one of the Statuses to which the Process 

Order can be transitioned has been reached, the Transition to this Status is not displayed. 

Change Any Process Order Status 

1. Select the desired Status hyperlink from the Process Order Status hyperlink category, or 

right-click on a Process Order in the Status column and select the desired Status. 

2. Dialog windows will ask the change to be confirmed. Click Yes to accept the Status change or 

No to reject it. 

Changing the Visible Columns or Rows 

Only the selected columns for Process Orders are displayed in the Schedule View.  These 

configurable settings remain after switching to and back from the Process Order Detail View. The 

initial columns shown are configured in the Administrator. 

Select Columns Visible in the Production Schedule 

1. Open the Change Column Visibility dialog box by one of the following methods: 

o From the View menu in the Schedule view, choose Select Process Order Columns 

o Click the Select Process Order Columns tool icon 

o Double-click any Process Order column header 
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o Right-click on a Process Order in any column except the Path or Status column and 

choose Select Process Order Columns.   

2. In the Change Column Visibility dialog box, double-click the items in the Hidden Columns and 

Visible Columns lists, or use the arrow buttons to move column names from one list to the 

other. 

Select Rows Visible in the Materials Tab (Details View) 

1. Double-click any row heading to open the Change Visibility dialog box. 

2. In the Change Visibility dialog box, double-click the items in the Hidden and Visible lists, or 

use the arrow buttons to move names from one list to the other. 

Completing an Active Process Order 

In the Schedule View display, the Active Process Order is indicated by a Status of Active.  The 

currently Active Process Order is used to track the Actual Quantity produced against a Process Order 

and its Planned Quantity.  Completing an Active Process Order allows a different Process Order to be 

activated.  If another Process Order has a Status of Next it will automatically become the Active 

Process Order when the current Active Process Order is Moved To Complete. 

Complete an Active Process Order 

1. Select the Change (Process Order) To Complete Status hyperlink from the Process Order 

Status hyperlink category, or right-click on a Process Order in the Status column and select 

the Status of Complete from the menu that is displayed. 

2. Choose Yes to Change Process Order [ProcessOrder] From Active to Complete. If Auto 

Promote From Next to Active is configured and another Process Order has a Status of Next, 

then that Order will automatically become the new Active Process Order. 

Creating a Child Process Order 

In the Schedule View display, a new Child Process Order is created with the specified name and 

properties. This allows parts of an order to be made on other Execution Paths.  The Links column of 

this Process Order contains the name of the Parent Process Order. The maximum product quantity 

available to be given to other Child Process Orders is reduced by the number given to the new Child 

Process Order. The quantity accumulated on a Child Process Order gets applied to the Parent as 

well. 

Create a Child Process Order 

1. If the Process Order is already Bound to a Path, then it is required to Unbind it prior to 

creating a Child Process Order. 

2. To Unbind the Process Order, select the UnBind (Process Order) hyperlink from the 

Process Order Actions hyperlink category. Click Yes to confirm. 

3. Select Create Child For (Process Order) from the Actions menu, or click the Create Child 

For (Process Order) tool icon, or in the Process Order Actions hyperlink category, click the 

Create Child For (Process Order) hyperlink, or right-click on a Process Order in any column 

except the Path or Status column and select Create Child For (Process Order). 

4. In the Create Child Process Order window, specify the Child Process Order's Name, Path, 

and Quantity.   
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5. To specify a desired Start and End time, click the Planned Start Time drop down and specify 

the desired times using the calendar.   

6. To insert the Child before or after a certain Process Order, click the Before/After Process 

Order drop down.  Select the desired insertion position (using the Before and After bullets) 

and select a Process Order from the Process Order combo box.   

7. When finished, click the Save button. 

Deleting Process Order Comments 

In the Schedule View display, comments made to a specific Process Order can be deleted for each 

Process Order if security allows access. 

Delete the Comments for a Process Order Manually 

1. Select View (Process Order) Comment from the View menu, or click the View Process 

Order Comment tool icon, or in the Process Order Actions hyperlink category on the right, 

click the View Process Order Comment hyperlink, or right-click on a Process Order in any 

column except the Path or Status column and select View Process Order Comment.  In the 

Comment For Process Order window, click the New Comment button.  In the text area, type 

the desired comment.  Click the Save Comment button. 

2. The Comment For Process Order: (Process Order) window is displayed.  In the text area, 

click the Delete Comment icon. 

3. Click the Save Icon to save the changes. 

4. Click [x] to close the Comment For Process Order: (Process Order) window when 

completed. 

Editing a Process Order 

The process order appears in the Schedule View when a time frame containing the specified process 

order's projected start time is set. All information specified when editing the process order is 

preserved throughout the Schedule View. 

Edit a Process Order 

1. Open the Edit Process Order dialog box by one of the following methods: 

o Choose Edit [Process Order] Properties from the Actions menu 

o Click the Edit [Process Order] Properties toolbar icon 

o In the Process Order Actions hyperlink category, click Edit [Process Order] Properties 

o Double-click a process order in any column other than Path or Status 

o Right-click in any column other than Path or Status and then choose Edit [Process 

Order] Properties 

2. In the Edit Process Order dialog box, change order parameters as required. Refer to Adding 

a New Process Order. 

3. When you have finished editing the process order, click Save. 

When you associate a bill of materials formulation with a process order, only the 

formulations associated with the selected product will be available for selection. 

Editing Process Order Run Times 
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In the Schedule View display, Edit Process Order Run Times calls up the selected Process Order in 

an editing window that allows the Start and End Times to be moved for each time frame the Order 

was run. 

Edit Process Order Run Times for a Process Order 

1. Select Edit (Process Order) Run Times from the Actions menu, or click the Edit (Process 

Order) Run Times tool icon, or in the Process Order Actions hyperlink category, click the 

Edit (Process Order) Run Times hyperlink, or right-click on a Process Order in any column 

except the Path or Status column and select Edit (Process Order) Run Times. 

2. The Edit Production Schedule Run Times dialog box is displayed. 

3. The Search functions on the hyperlink menu are Goto Specific Time, Goto Previous 

Transition, or Goto Next Transition for this Process Order. 

4. The View functions on the hyperlink menu on the right allow the Widen Time Frame, Scroll 

Forward, or Scroll Backward. 

5. The Actions functions on the hyperlink menu allow the Start and End Times for the Process 

Order to be shifted forward or backward. 

Editing Process Order Comments 

In the Schedule View display, comments made to a specific Process Order can be edited for each 

Process Order if security allows the user access. 

Edit the Comments for a Process Order 

1. Select View (Process Order) Comment from the View menu, or click the View Process 

Order Comment tool icon, or in the Process Order Actions hyperlink category on the right, 

click the View Process Order Comment hyperlink, or right-click on a Process Order in any 

column except the Path or Status column and select View Process Order Comment.  In the 

Comment For Process Order window, click the New Comment button.  In the text area, type 

the desired comment.  Click the Save Comment button. 

2. The Comment For Process Order: (Process Order) window is displayed.  In the text area, 

type the desired comment. 

3. Click the Save Icon to save the changes. 

4. Click [x] to close the Comment For Process Order: (Process Order) window when 

completed. 

Moving a Process Order Backward 

In the Schedule View display, the selected process order can be moved up one row on the path it is 

bound to (switching places with the process order above it). The status the process order is in must 

have the Enable <status name> PO Ordering feature enabled in the Administrator. Typically, you 

can only move within the same status unless Sort With was enabled when you configured the 

production execution path. 

Move a Process Order Backward 

 Select Move Process Order Backward from the Actions menu, or click the Move Process 

Order Backward tool icon, or in the Process Order Actions hyperlink category, click the 

Move Process Order Backward hyperlink, or right-click on a Process Order in any column 

except the Path or Status column and select Move Process Order Backward. 
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Moving a Process Order Forward 

In the Schedule View display, the selected Process Order is moved down one row on the Path it is 

Bound to (switching places with the Process Order above it). The Status the Process Order is in must 

have the Movable feature enabled in the Administrator. Typically, you can only move within the same 

status unless the Sort With feature is enabled in the Administrator. 

Move a Process Order Forward 

 Select Move Process Order Forward from the Actions menu, or click the Move Process 

Order Forward tool icon, or in the Process Order Actions hyperlink category, click the 

Move Process Order Forward hyperlink, or right-click on a Process Order in any column 

except the Path or Status column and select Move Process Order Forward. 

Pausing a Process Order 

In the Schedule View display, the Active Process Order is indicated by a Status of Active.  The 

currently Active Process Order is used to track the Actual Quantity produced against a Process Order 

and its Planned Quantity.  Pausing a Process Order allows it to be set to Pending to be completed at 

a later time. 

Pause a Process Order Manually 

1. Select the Status hyperlink Change (Process Order) To Pending from the Process Order 

Status hyperlink category, or right-click on a Process Order in the Status column and select 

the Status of Pending. 

2. Select Yes to Change Process Order [Process Order] From Active to Next. 

Reworking a Process Order 

In the Schedule View display, the Re Work option allows a new Process Order to be created with the 

specified name and properties, and is added to the proper path.  The Process Order's type is labeled 

with red text as Re-run in the Status column. 

Rework a Process Order 

1. Select Re Work (Process Order) from the Actions menu, or click the Re Work Process 

Order tool icon, or in the Process Order Actions hyperlink category, click the Re Work 

(Process Order) hyperlink, or right-click on a Process Order in any column except the Path 

or Status column and select Re Work (Process Order).   

2. Specify the new Process Order name, Source Process Order, Start Time, and Quantity to be 

Re Worked.   

3. Click the Save button. 

Returning Child Process Order to Parent 

In the Schedule View display, child Process Orders allow parts of an order to be made on other 

Execution Paths. The quantity accumulated on a Child Process Order also gets applied to the Parent 

Process Order. 
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Return to Parent Process Order from a Child Process Order 

 Select Return (Process Order) To Parent from the Actions menu, or right-click on a 

Process Order in any column except the Path or Status column and select Return (Process 

Order) To Parent. 

Unbinding a Process Order from a Path 

In the Schedule View display, the selected Process Order is removed from the Path to which it was 

previously bound. If the Display Unbound Process Orders display option is set to True (this value is 

set in the Display Options from the Administrator), the unbound Process Order is displayed below all 

Path-bound process orders, with no information displayed in the Path column. 

Unbind a Process Order from a Path 

1. Select the UnBind (Process Order) hyperlink from the Process Order Actions hyperlink 

category. 

2. Click Yes to confirm. 

Viewing a Specific Time in the Schedule 

In the Schedule View display, the viewing window is adjusted to display only the Process Orders 

whose forecasted duration is partially or completely contained by the new time frame of the Schedule 

View, and those that are linked to such Process Orders. 

View a Specific Time in the Schedule 

1. Select Go To Time tool icon, or in the Search hyperlink category on the right, click the Go To 

Time hyperlink, or right-click on a Process Order in any column other than the Status or Path 

column and select Go To Time. 

2. From the Select Date window, make changes by typing over the current date/time or using 

the arrow keys to scroll one piece of the date/time at a time. 

Viewing Child Process Orders 

In the Schedule View display, child Process Orders allow parts of an order to be made on other 

Execution Paths. The quantity accumulated on a Child Process Order also gets applied to the Parent 

Process Order. 

View Child Process Orders for a Process Order 

 Select View Children For (Process Order) from the Actions menu, or click the View 

Children For (Process Order) tool icon, or right-click on a Process Order in any column 

except the Path or Status column and select View Children For (Process Order). 

Viewing Parent Process Orders 

In the Schedule View display, child Process Orders allow parts of an order to be made on other 

Execution Paths. The quantity accumulated on a Child Process Order also gets applied to the Parent 

Process Order. 
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View Parent Process Orders for a Child Process Order 

 Select View Parent For (Process Order) from the Actions menu, or click the View Parent 

For (Process Order) tool icon, or right-click on a Process Order in any column except the 

Path or Status column and select View Parent For (Process Order). 

Viewing the Process Order History 

In the Schedule View display, the history of changes made to a specific Process Order can be viewed 

for each Process Order. 

View Historical Changes for a Process Order 

1. Select View Process Order History from the Tools menu, or click the View (Process 

Order) History tool icon, or in the Process Order Actions hyperlink category on the right, click 

the View (Process Order) History hyperlink, or right-click on a Process Order in any column 

other than the Status or Path column and select View (Process Order) History. 

2. A History window of all changes made to the Process Order is shown. 

3. Click [x] to close the History window when completed. 

Viewing Process Order Comments 

Comments made to a specific Process Order can be viewed for each Process Order. 

View Comments for a Process Order 

1. Select View (Process Order) Comment from the View menu, or click the View Process 

Order Comment tool icon, or in the Process Order Actions hyperlink category on the right, 

click the View Process Order Comment hyperlink, or right-click on a Process Order in any 

column except the Path or Status column and select View Process Order Comment.  In the 

Comment For Process Order window, click the New Comment button.  In the text area, type 

the desired comment.  Click the Save Comment button. 

2. The Comment For Process Order: (Process Order) window is displayed. 

3. Click [x] to close the Comment For Process Order: (Process Order) window when 

completed. 
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Sequence of Events (SOE) Display 
Anatomy of a Sequence of Events (SOE) Display 

Sequence of Event Displays are identified with the Sequence of Event icon . These displays 

interact with all event types, which can be sorted by time. Detailed information is provided for 

production, product change, and downtime, waste, and user-defined events. Key features of the 

screen are as follows: 

 The chronology of all events can be viewed in the left-hand window pane. 

 Sub-events can be viewed by clicking the event. 

 Detail for currently selected event in lower-right window. The display option, 

DisplayDetailPanel must be set to True to view the detail panel in the SOE display. 

Key Uses 

 Review Downtime and Waste Events 

 Review Other Types of Events In Sequence with Downtime and Waste 

 Interact with Research Fields for Downtime and Waste 

 Enter User-defined Events 

Key Data 

 All Data from Downtime and Waste 

 Research Fields for Downtime, Waste, User-defined Events 

 User-defined Event Times 

 User-defined Event Reasons 

 User-defined Event Comments 

Adding User-Defined Events 

You must configure a User-Defined Event (UDE) before you can add one in an Autolog or Sequence 

of Events (SOE) display. For more information, see Configuring User-Defined Events on a Production 

Unit. 

Add a User-Defined Event 

1. Do one of the following: 

o Add a new column in an Autolog UDE display. 

o Right-click an SOE event to add a UDE around it (in terms of time). 

2. Select Add User Defined Event. The Add User-Defined Events dialog box appears. 

3. On the General tab, do the following: 

a. Select the UDE from the Event Type list. 

b. In the Description box, type a brief description of the User-Defined Event. The 

description will be displayed in the list of events. This is step is optional. 

c. In the Status field, select a status. The default status that was selected when creating 

a UDE (refer to Creating a User-Defined Event is initially displayed. 
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TIP:  If the Status field is locked and does not allow an entry, it means that a default 

status was not selected when creating a UDE. 

d. The Timestamp box is automatically filled with the timestamp of the event that you 

clicked in step 1. To insert the UDE at the current time, click Now. 

4. On the Cause tab, select a default cause for the user-defined event. 

5. On the Actions tab, select a default action for the user-defined event. 

6. On the Research tab, do the following: 

a. From the User list, select a user who is responsible for researching the user-defined 

event. 

b. From the Research Status list, choose either Open or Closed. 

c. Click Open Date to identify the date the case was opened. 

d. Click Close Date to identify the date the case was closed. 

7. Click the History tab to view a history of the event. 

8. Select OK to save the new user-defined event. 

Modifying Event Details in an SOE Display 

Follow these steps to modify event details in an SOE display: 

1. Select an Event to view details for. 

2. Right-click and select Show Details. 
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Trend Display 
Anatomy of a Trend Display 

Trend Displays are identified with the Trend Display icon .  A Trend Display is a real-time display 

designed for trending variables against product-based specifications or recipe limits. Trends 

summarize quality and process data by time or event. Historical trends and product specifications 

(recipe limits) can be reviewed. Trends can include the following information: 

 Overall display information at the bottom of the Trend Display 

 Variable trends in each rectangle 

 Variable alarm state highlighted with a colored border around a rectangle 

NOTE:  Starting with Plant Applications 6.2.2, control limits can be automatically calculated 

as an option based on a configurable sample size. When available, calculated sigma values 

are reflected by control limits in trend charts. 

Key Uses 

 Trend Summarized Event or Time-Based Data 

 Compare Trends to Specification Limits 

 Review Historical Trends 

Key Data 

 Summarized Quality and Process Data 

 Product Specifications / Recipe Limits 

 Data Point Comments (Annotations) 

Viewing Trend Details 

Follow these steps to view Trend Details: 

1. Double-click an individual Trend to resize it to full screen. 

2. Hover the mouse pointer over individual data points to see details and comments 

3. Double-click on the Trend to return to normal size. 

Changing the Time Range 

Change the time range in a Trend Display as follows: 

1. Select the Get Trend Time icon in the toolbar. 

2. Enter the Start and End Times for the trend using the Data and Time selection fields. 
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Waste Display 
Anatomy of a Waste Display 

This information applies to the classic Waste Display. 

Waste Displays are identified with the Waste icon . The classic Waste Display is used to interact 

with Waste detail data. Waste events and reasons can be automatically detected or manually entered 

via an Autolog Display. You can also attach comments or documents to each event. Key features are 

as follows: 

 Red indicates missing Reasons. 

 Production event without details is shaded in yellow. 

 Time-based Waste is shaded in light green. 

 Total Waste for an event is in the Amount column. 

Key Uses 

 Review automatically detected waste events 

 Manually enter waste details on time basis 

 Manually enter waste details on "production event" basis 

 Manually change downtime reasons 

 Add comment and attach documents to waste events 

Key Data 

 Waste timestamp 

 Waste "production event" (Batch, etc.) 

 Waste cause location 

 Waste type 

 Waste amount 

 Waste unit of measure 

 Waste cause reasons 

 Waste action reasons 

 Waste comments 

Adding Waste Events to a Waste Display 

This information applies to the classic Waste Display. 

Add a Waste Event 

1. Do one of the following: 

o Right-click on the row where you want to add an event and click Insert New Event 

from the pop-up menu. 

o From the Actions menu, click Insert New Menu. 



Plant Applications Client 

83 

2. In the Insert Waste dialog box, enter the following information: 

o optional: In the Date box, edit the default date. By default, the date is the date of the 

event you have selected. 

o optional: In the Time box, edit the default time. By default, the time is the time of the 

event you have selected. 

o In the Location box, type the cause location of the waste event. 

Based on the location you enter, you may be required to identify the 

production event associated with the waste event. 

o optional: In the <event name> box, select a different production event from the 

drop-down list. By default, the production event is the production event you have 

selected. 

o In the Amount box, type the amount of waste. 

o In the Units box, select the units of measurement from the drop-down list. 

o optional: In the Fault box, select a Fault from the drop-down list. 

o optional: In the Category box, select a Category from the drop-down list. 

o optional: In the Reason box, select a Reason from the drop-down list. 

3. Do one of the following: 

o To insert the event and create additional events, click Apply. 

o To insert this event and close the dialog box, click OK. 

If you click Apply and then OK, you'll insert the event twice. 

Changing Visible Columns in a Waste Display 

This information applies to the classic Waste Display. 

You can control the data that is displayed in a Waste display by displaying or hiding columns. 

Display or Hide Columns 

1. From the View menu, click Column Visibility. 

2. In the Change Column Visibility dialog box, do one or more of the following: 

o To display additional columns, under Hidden Columns, select the column(s) you 

want to display and click the Move Selected  button. 

To display all columns, click the Move All  button. 

o To hide columns, under Visible Columns, select the column(s) you want to hide and 

click the Remove Selected  button. 

To hide all columns, click the Remove All  button. 

3. Click the Close  button to close the dialog box. 

Commenting Waste Events in a Waste Display 

This information applies to the classic Waste Display. 

Adding comments is a great way to provide additional information. Comments can be either text that 

you type, or you can paste a link to an external document, such as a Microsoft Word document. 
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Keep in mind that if you paste a link to a document, the document cannot be moved to a different 

folder or directory; otherwise, the link will be broken and the document will not be found. 

Comment Waste Events 

1. If you cannot see the detail rows, do one of the following: 

o To expand only one Summary row, select the Summary row you want to expand and 

click the Expand Event button  

o To expand all Summary rows, click the Expand All Events button  

2. Right-click the Detail row you want to comment, and click Add Comment. 

3. In the Comment window at the bottom of the screen, type the comment or paste a document 

and click the Save button . 

The Pencil icon indicates Detail rows that have comments added. 
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Waste+ Display 
Anatomy of a Waste+ Display 

This information applies to the Waste+ Display. 

The Waste+ display enables plant floor operators to view and edit waste events, using either a touch 

screen or keyboard for navigating the display. The following image shows the Waste+ display in touch 

screen mode. A classic Waste Display is also available to interact with Waste detail data.   

The Waste+ display in touch screen mode highlights information as follows: 

 Red text indicates missing reasons. 

 Rows that are shaded yellow indicate production events without details. 

 Rows that are shaded light green indicate time-based waste. 

 Black text indicates the event is complete and all the required information has been provided. 

A Waste+ screen includes these areas: 

 

1 Click or tap Grid Actions to: 

 Manually create a waste event, click or tap Insert Record. 

 Locate a waste event within a specific time period, click or tap Go to Date. The Date/Time 

Entry panel appears. 

 Hide confirmed waste events, click or tap Hide Confirmed. 

 Filter on selected columns, click or tap Build Advanced Filter. 

 Filter waste events by amount, click or tap Amount Filter and use the slider. 
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2 Click or tap Row Actions to: 

NOTE: You must select a row to view or use Row Actions. 

 Expand grouped waste events, click or tap Expand Group. 

 Delete the selected waste event, click or tap Delete. 

 Copy and paste reasons, click or tap Copy Fault/Reasons. To copy and paste reasons, you 

must first view the waste event details, then copy and paste the reasons. 

3 Click or tap a cell in the waste event row to edit reasons, amounts, and other information. Based 

on the selected cell, the appropriate panel (4) appears. 

4 When you click or tap a row or a cell in a row, a panel appears with the appropriate data entry tools 

or selections. 

5 Click or tap Change Size Mode to change to or from touch screen mode. This button is visible only 

if the display option, Allow Mode Toggle, has been set to True by the Plant Applications Administrator. 

For information about the display options, see Configuring a Waste+ Display. 

6 When you change to touch screen mode, the on-screen keyboard button appears. Click this button 

to use the on-screen keyboard. 

7 Select values easily by dragging the sliders. 

8 The time range of the waste events is displayed at the top of the display. 

9 Use the scroll buttons to page through the events in increments that are equal to one-fourth the 

time specified by the Initial Windows Setting. 

Navigating the Waste+ Display 

This information applies to the Waste+ Display. 

To make selections in the Waste+ display, you can click with a mouse or tap (using your finger or 

stylus). You can also use the arrow keys on your keyboard to make selections and move around the 

display. 

1. Click or tap a cell in the display or click or tap a row and use the arrow keys to select a cell. 

The appropriate panel is displayed. 

2. Press ENTER or tap the panel. The panel becomes active. 

3. Tap the buttons or press the arrow keys to choose a button or select a box and use the 

keypad to enter a new value. 

Using Touchscreen Mode (Waste+) 

This information applies to the Waste+ Display. 

The Waste+ display enables the use of a touch screen. To facilitate the use of a stylus or other 

tapping device, you can change the size of the text and buttons. You can also use an on-screen 
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keyboard to enter text. The Change Size Mode button is visible only if the display option, Allow Mode 

Toggle, has been set to True by the Plant Applications Administrator. For information about the 

display options, see Configuring a Waste+ Display. 

Enter the Touch Screen Mode 

1. Click or tap the Grid Actions tab. 

 

2. Click Change Size Mode. The text and buttons become larger and the On-screen Keyboard 

button appears. 

 

3. Click the On-screen Keyboard button to open the on-screen keyboard. By 

default, Microsoft's On-Screen Keyboard is used.  

 

4. Click Change Size Mode to exit touch screen mode. 

Editing Event Timestamp (Waste+) 
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This information applies to the Waste+ Display. 

Click or tap a cell in the Time column to display the Date/Time Entry tab where you can edit the 

selected time. 

Edit an Event Timestamp 

1. Click or tap a cell in the Time column to display the Date/Time Entry panel. 

 

NOTE: You must click or tap the cell of a detail record and not a summary record. 

2. Click or tap one of the entry fields to adjust the value. Click or tap the arrows to change the 

value. 

3. Slide the toggle to switch between AM and PM. 

4. Click or tap an entry field and then use the arrow buttons or slider to select a value. The scale 

of the slider changes automatically based on the selected entry field. 

5. Click or tap OK to save your changes or click Cancel to cancel your changes. 

6. After you click or tap OK, you can click or tap Cancel Changes to cancel the changes that 

you have made. 

Filtering Waste+ Events 

This information applies to the Waste+ Display. 

In the Waste+ display, you can filter events by one or more of the values in a column. You can also 

filter confirmed events and filter events by amount. 

Filtering uses AND logic to determine the results that are returned. This means that the records that 

are returned must meet all the criteria you select. Consider the following records: 

Column 1 Column 2 Column 3 

A Red Square 



Plant Applications Client 

89 

A Yellow Oval 

A Yellow Oval 

B Red Round 

If you selected A and B from Column 1 and Red from Column 2 and Oval from Column 3, no records 

would be returned because no single row matched all criteria. However, if you selected A and B from 

Column 1 and Red and Yellow from Column 2 and Square and Oval from Column 3, three records 

would be returned. 

NOTE: When filtering is applied, summary records are not displayed; however, the detail 

records belonging to the summary records will be displayed, if they meet the filter criteria. 

Use the Advanced Filter 

1. Click or tap Grid Actions. 

 

2. Click or tap Build Advanced Filter. A message box appears. 
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3. Click or tap Yes to start selecting what you want to filter on. The Build Advanced Filter 

becomes the Apply Advanced Filter button. 

4. Click or tap a value in a cell. A panel appears with the available choices. 

 

5. Click or tap one or more of the choices and click the text "Click here to confirm selection." 

6. To filter by additional columns, click or tap another cell in a different column and select one or 

more of the available choices. Although you can make more than one selection per column, 

you can only select a column once. 

7. After you have selected all the values you want to filter on, click or tap Apply Advanced 

Filter. The waste records are filtered, and the Apply Advanced Filter button becomes the 

Clear Advanced Filter button. 
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8. To clear the filter and display all of the waste records, click or tap Clear Advanced Filter. 

Filter by Waste Amounts 

1. Click or tap Grid Actions. 

 

2. Click or tap Amount Filter and drag the slider to the desired amount. Waste events with a 

amount equal to or greater than the selected amount are displayed. 

3. Click or tap Amount Filter to display all waste events. 

Show or Hide Confirmed Waste Events 

1. Click or tap Grid Actions. 
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2. Click or tap Hide Confirmed. Waste events that have incomplete information (for example, 

no faults or reasons) are displayed. 

 

Confirmed events are those events that have a reason tree attached and all reason levels 

within the reason tree have been entered. 

3. Click or tap Hide Confirmed to display all waste events within the specified window. 

Saving a Filter 

This information applies to the Downtime+ and Waste+ displays. 

You can save a filter in a Downtime+ or Waste+ display so that when the display is opened, by 

anyone, the saved filter is automatically applied. Additionally, if a new filter is applied to the display, 

the saved filter will be applied when the display is re-opened. 

The procedure to save a filter should be performed by an administrator or someone with advanced 

knowledge of Plant Applications. Furthermore, this procedure must be followed for each display for 

which you want to save a filter. 

Step 1: Modify LocalSettings.xml to Capture the Filter Information 

1. Locate LocalSettings.xml, which is located in the ..\Plant Applications\Client folder. 

2. Open LocalSettings.xml in Notepad or another text editor. 

3. Search for the element, PermitPersistenceStringLoad and change the value from false to 

true. 

4. Save and close LocalSettings.xml. 

Step 2: Capture the Filter Information from the Display 

1. Open Plant Applications Client and open a Downtime+ or Waste+ display. 

2. Filter the information in the display. For information about applying filters, see the topic 

Filtering downtime events or Filtering waste events. 

3. With the filter applied, close the display and close Plant Applications Client. 

Step 3: Copy the Filter Information 

1. Locate LocalSettings.xml and open it in Notepad or another text editor. 

2. Search for the element, LastPersistenceData. 

3. Confirm that the value for DisplayType and SheetName match the display you just closed. 

4. Copy all tags and data, starting with <LastPersistenceData and including 

</LastPersistenceData>. Example: 

<LastPersistenceData DisplayType="Downtime+" SheetName="DT"> 

      <data> 

        <filters> 

          <filter type="advanced"> 

            <values column="Reason_Level1"> 

              <value>Not Scheduled</value> 

            </values> 

          </filter> 
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        </filters> 

      </data> 

    </LastPersistenceData> 

5. Open a new document in your text editor and paste the copied information. 

6. Remove all line breaks and tab characters so that the text is all on one line. Example: 

<LastPersistenceData DisplayType="Downtime+" 
SheetName="DT"><data><filters><filter type="advanced"><values 
column="Reason_Level1"><value>Not 
Scheduled</value></values></filter></filters></data></LastPersistence
Data> 

7. Copy the single line. 

Step 4: Save the Filter Information in the Persistence String Display 
Option 

1. Open Plant Applications Administrator. 

2. Expand Client Management and expand Displays. 

3. Right-click the appropriate Downtime+ or Waste+ display and click Edit <display name>. The 

Edit Display dialog box appears. 

4. Click the Display Options tab. 

5. Under the Sheet Persistence heading, edit the Persistence String display option: 

a. Click the Edit button. The Assign Property Value dialog box appears. 

b. In the Value box, paste the single line you copied previously in Step 3: Copy the filter 

information. 

c. Click OK. 

6. Save and close the Edit Display dialog box. 

NOTES: 

To temporarily clear the saved filter, click the Clear Advanced Filter button in the 

display. 

To change the saved filter, repeat all of the preceding steps. 

To remove the saved filter, remove the string from the Persistence String display 

option. 

Adding a Waste+ Event 

This information applies to the Waste+ Display. 

Waste events can be manually added using the waste display. 

Manually Enter a Waste Event 

1. Click or tap Grid Actions. 
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2. Click or tap Insert Record. An empty row (the working row) is added to the top of the rows of 

waste events and the Data/Time Entry panel appears. 

 

3. Enter the time of the waste event and click or tap OK. After you enter the time, the cell to the 

right becomes active and the appropriate panel appears. 

4. Continue entering the waste information. 

Finding Waste Events 

This information applies to the Waste+ Display. 
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You can search for a waste event within a specific time frame, which is defined by the Initial Windows 

Setting. The displayed waste records are calculated as follows: 

(Start Time – Initial Windows Setting) to End Time. 

For example, if the Initial Windows Setting is 24 hours (the default) and the date entered on the 

Date/Time Entry expander window is Wednesday, November 28, 2007 3:30pm, all waste records 

between Tuesday, November 27, 2007 3:30 PM and Wednesday, November 28, 2007 3:30 PM are 

displayed. If either end time falls within a waste event, the waste event is not included in the waste 

events that are displayed. In this example, a waste event that occurred on Tuesday, November 27, 

2007 with a start time of 3:20 PM and an end time of 3:40 PM would not be displayed. 

Search for a Waste Event 

1. In the Waste+ display, click or tap Grid Actions and click or tap Go to Date. The Date/Time 

Entry panel appears. 
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2. Enter the date and time and click OK. The waste records within the defined window are 

displayed. 

3. Use the  scroll buttons to page up or down in increments that are equal to one-fourth the 

time specified by the Initial Windows Setting, until the time range specified by the MAX 

display setting is reached, then it begins moving the start time and end time down in 

increments one-fourth the MAX time specified. 

Entering Comments for a Waste+ Display 

Adding comments to a Waste+ display is a useful way to provide additional information. Comments 

can be either text that you type or a link to an external document, such as a Microsoft Word 

document. 

Keep in mind that if you paste a link to a document, the document cannot be moved to a different 

folder or directory; otherwise, the link will be broken, and the document will not be found. 

NOTE: Comments are categorized as either Reason, Action, or Research comments. All 

Reason comments are listed first in the Comments window. 

Add Comments to a Waste+ Event 

1. Select a row In the Waste+ display, and select the Row Actions tab. 
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2. Click the New Comment button or the Manage Comments button. 

3. In the Comments dialog box that appears, select Reason, Action, or Research from the 

drop-down menu. Type your comment in the box, which supports simple text with no 

formatting. You can also type URLs to documents and web sites. 
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4. Click or tap the Save button to save your comments. Waste events with comments are 

indicated with the  icon, which is displayed beside the row item. 

Copying Faults and Reasons (Waste+) 

This information applies to the Waste+ Display. 

You can quickly enter or change faults and reasons for a waste record. 

Copy Faults and Reasons 

1. Select a waste event. You can click or tap anywhere in the row. 

2. On the Row Actions tab, click or tap Copy Fault/Reasons. 

T

 

3. Select the waste event where you want to paste the faults and reasons. You can click or tap 

anywhere in the row. 

 

To select multiple rows, click the row header for the first row and drag to select additional 

rows. 

 

 

4. On the Row Actions tab, click or tap Paste Fault/Reasons. The fault and reasons are 

changed. 
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Troubleshooting 
SQL Connection Error 

A Reconnecting message will appear when the Client attempts to execute a database command and 

the SQL Server connection has been interrupted. This could be because SQL Server shutdown, 

restarted, lost its network connection, a computer stopped responding, or cluster failover. This does 

not include the Client losing its network connection. 

If the connection to SQL Server cannot be restored, the SQL Connection Error dialog box will 

appear. By default, reconnection will be attempted in 10 seconds. However, you can force the 

reconnection by clicking Retry or you can stop the attempt to reconnect by clicking Abort. 

NOTE:  If you click Abort, all open displays will be closed, all buffered data will be lost, and 

the Client will be closed. 

The amount of time to attempt a reconnection is controlled by the DatabaseReconnectionRetryTime 

site parameter. 

Data Outside Visible Time Range 

The client computer system data and time cannot be significantly different from the Proficy server. If it 

is, you may see the following error message: 

 

The data you are trying to insert is outside the visible time range, and cannot be posted. 

Please navigate to the time period you want to update, or change your input time. 

If you receive this error message, you must ensure that all computers connecting to the Proficy server 

have synchronized the system clock. Plant Applications does not support cross-time zone use. 

Timestamps are determined by the Proficy server and not by the client computer. 

Display Does Not Open 

This information applies to the Downtime+ and Waste+ displays. 

A message will appear in the Plant Applications Client message log indicating the error in instantiating 

the control. 

This can occur if the Plant Applications Client installation does not complete or if errors occurring 

during installation that prevent the necessary .dlls from being installed. 

 Ensure that Microsoft .NET Framework 3.0 or higher is installed. 

 Ensure that the following .dlls are registered. 

o Microsoft.InteropFormTools.dll 

o PlantApps.WPFDisplays.DisplayWrapper.dll 

o PlantAppsWPFControls.ocx 

 Ensure that the Plant Applications ISI is installed. 

Display Has Been Deleted 
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This information applies to the Downtime+ and Waste+ displays. 

Error message: This Sheet has been deleted. Unable to continue. 

Under normal circumstances, the Client container window should trap this error and report it. If the 

display reports this error in a message box, it is likely that the display was deleted after the Client 

invokes the display and before the display begins reading its settings from the database. 

This may also occur as a result of server or network failure. 

Another possibility is that a non-ASCII character was used in the naming of the display and as a 

result, the Sheet Display Options cannot be loaded by name. Check the name of the display in the 

Plant Applications Administrator. 

Grid Population Fails 

This information applies to the Downtime+ and Waste+ displays 

Error: Grid population failed at: _____ 

For example, "Grid population failed at: LocalSettings" 

A known condition has occurred during start-up which prevents the display from loading. Known 

conditions are trapped during the following procedures, indicating where the problem is. Normally this 

suggests corrupt data in the configuration tables or support files. 

 LocalSettings: The XML configuration file "LocalSettings.xml" in the Client install directory on 

the local machine is corrupt, the XML is invalid, or one of the values contains an illegal or 

unparseable character. Open the .xml file in Internet Explorer to determine where the error is. 

Replace the LocalSettings.xml file with a back-up, or the standard deployed version. 

 DisplayOptions: The database connection was lost during display option loading, or one of the 

display options saved for this display is invalid or corrupt. Display option values for a display 

are stored in the Sheet_Display_Options table. Ensure that there are valid values of the 

correct datatype for each display option. If necessary, you can delete all display option values 

for the corresponding display and re-set them in the Plant Applications Administrator. 

Because most display options are available as drop-down lists, the NumberFormat option 

could be most easily corrupted. 

 ColorScheme: The database connection was lost during color scheme loading, or one of the 

color scheme values saved for this sheet is invalid or corrupt. Color Scheme values are 

stored in the Color_Scheme_Data table. Ensure that the values stored are valid. 

 SecurityConfig: The database connection was lost during security config loading, or one of 

the security display options saved for this sheet is invalid or corrupt. Display option values for 

a sheet are stored in the Sheet_Display_Options table. Ensure that there are valid values of 

the correct datatype for each display option. 

 ApplyNLS: The database connection was lost during language prompt loading, or one of the 

language strings was corrupt. 

 ApplySecurity: One of the security display options, while a valid value, could not be parsed as 

Boolean (meaning True/False) against the current user level. This suggests an unknown user 

level or a corrupt display option value. 

 Subscribe: The display was unable to subscribe to events on one of the display's production 

units. Ensure that all production units on the display have the correct event configuration. 

Ensure that the production units on the display still exist. Ensure that the ISI is installed 

properly and functioning normally. Ensure that the Proficy Server services are running. 
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Unknown or Unhandled Error Condition 

This information applies to the Downtime+ and Waste+ displays 

Error: The display was unable to open because an exception was thrown during start-up. Check the 

error log for more information. The exception thrown was: ___ 

– or – 

An incorrect result is displayed on the grid after an otherwise successful initial load. 

If an error message appears, the .NET exception message will be listed below. Check that the 

display’s initial result-set is valid and contains no corruption or duplicate (non-unique) records. See 

Validating a Downtime+ or Waste+ Result Set for instructions on how to inspect the result set. Retain 

the .xml result for inspection by Technical Support, if necessary. 

If the error still cannot be isolated, enable logging on the display, re-open, and inspect the log file to 

find the exact error. Logging is extremely detailed, and module-specific. It is recommended that you 

use the application Chainsaw to read the logging results. A document on enabling logging is 

forthcoming and will be sent at a later date. 

If Technical Support is unable to troubleshoot the problem using the log file, capture the original error 

message for additional troubleshooting. 

Validating a Downtime+ or Waste+ Result Set 

This information applies to the Downtime+ and Waste+ displays 

To inspect the resultset of a given display: 

1. Stop the Plant Applications Client, if running 

2. Open the file "LocalSettings.xml" in the Client install directory on the client computer. 

3. Edit the node <DebugMode> and set the value to True. 

4. Save the LocalSettings.xml file. 

5. On the root of the C: drive on the client computer, delete any file called DebugWPFWaste-

DataSet.xml or DebugWPFDowntime-Dataset.xml. 

6. Start the Plant Applications Client and open the display that caused the error. The display will 

look different. This is normal when debug mode is enabled. 

7. On the root of the C: drive, find the file DebugWPFWaste-DataSet.xml for a waste display or 

DebugWPFDowntime-DataSet.xml for a downtime display. 

8. Open the file in Internet Explorer to look for errors. The following common errors might be 

immediately visible. 

o The file is completely empty: An error has occured in the retrieval of data, such that 

no result-set (not even an empty one) is returned. Ensure that at least one production 

unit on the display has a collection model configured for the display type. Ensure that 

there is at least one production unit assigned to the display in Admin. 

o Internet Explorer returns an error when opening the file: The dataset is corrupt 

because it contains an invalid character that cannot be parsed by the display. Inspect 

the database for corrupt data. 

o A repeating node is found: Each data point in the result set must have a unique ID. If 

a data point contains a non-unique ID, an error has occurred in the stored procedure 

which retrieves the data. This may suggest a configuration problem or a bug in the 

stored procedure. 
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9. When finished troubleshooting, re-open the LocalSettings.xml file and set the <DebugMode> 

node back to False. 

10. Save the LocalSettings.xml file. 

11. Close and re-open the Plant Applications Client. 
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